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Preface
Welcome to the FIRESTAT User’s Guide.  This guide is designed to help you 
access and use FIRESTAT version 5.2.

The Contents at the front of this guide help you find topics easily.  Each 
chapter explains specific topics and tasks you must know to effectively use 
FIRESTAT.  An appendix that contains additional coding information is 
located in the back.

We hope you find this guide friendly and easy-to-use.  If you have any 
questions, comments, or concerns, please contact:

USDA Forest Service
National Fire and Aviation Management 

Information Systems Team
3833 S. Development Avenue
Boise, ID  83705-5354

1-800-253-5559

You can email us at:

fire_help@dms.nwcg.gov

Windows 95, Windows 98, Windows 2000, and Windows NT are registered trademarks of Microsoft Corporation.  This guide 
employs many styles, conventions, and guidelines established in the “Microsoft Manual of Style for Technical Publications.”
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For State Code = 49 - Utah    . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.67
For State Code = 50 - Vermont    . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.67
For State Code = 51 - Virginia  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.67
For State Code = 53 - Washington   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.70
For State Code = 54 - West Virginia   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.70
For State Code = 55 - Wisconsin   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.72
For State Code = 56 - Wyoming   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.73

Wilderness areas by Region  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.74

Region 1   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.74
Region 2   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.75
Region 3   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.77
Region 4   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.79
Region 5   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.81
Region 6   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.83
Region 8   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.87
Region 9   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.90
Region 10   . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A.91

Glossary  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . G.1



Chapter 1.  About this guide
This FIRESTAT User’s Guide shows you how to enter Individual Fire Report 
information using form FS-5100-29 and other sources.  It is organized to help 
you locate and perform specific FIRESTAT functions quickly and easily.

This FIRESTAT User’s Guide is a work-in-progress.  Updates to this guide will 
be included as these become available.

Before you begin
Before using the FIRESTAT software, you must feel confidant that:

• You are familiar with your personal computer and function keys and 
understand personal computer concepts.

• You are familiar with using the US Forest Service IBM hardware and 
software platform and can perform basic Windows 95 functions.

• You must be familiar with fire reporting terminology and fire information 
concepts.  

How to use this guide
Each chapter explains a specific functional area of the FIRESTAT system.  
Chapter titles are shown at the top of each page.  At the beginning of each 
chapter you will find a chapter overview and a picture and related field 
descriptions of every form discussed within the chapter.

Chapter 1, “About this guide,” introduces the FIRESTAT User’s Guide and 
explains how to use it.

Chapter 2, “Getting started,” explains some of the basic information you need 
to begin using FIRESTAT.  It introduces access roles, basic navigation skills, 
and local limits.

Chapter 3, “Working with wildland fire reports,” explains how to create, edit, 
and print wildland fire reports.

Chapter 4, “Generating and transmitting fire reports,” explains how to 
transmit completed fire reports to the National  Interagency Technology 
Center (NITC).

Appendix A, “Codes,” contains additional coding information you need to 
complete specific fields for Individual Fire Report. form “FS-5100-29.”

The Glossary lists terms and definitions used in this guide. 

References are arranged alphabetically and contain sources of information 
used to complete this guide.
January 10, 2002 version 5.2 1.1



Chapter 1. About this guide FIRESTAT User’s Guide

1.2 version 5.2 January 10, 2002

Conventions
The following conventions are used within this guide:

• Menu options and field names appear in bold, in the same case as on your 
screen or keyboard.  Hard label keys appear in small capital letters.  For 
example, a step in a procedure might instruct you to
• On the Help menu, click Show Keys or press CTRL + F1.

• System responses, such as messages written to the screen, appear in the 
same case as displayed on your screen.  For example, the following text 
might appear when you save a record

Enter value for : FIRE NAME

• A plus sign (+) between hard label keys, such as CTRL + F4, means to 
press and hold the first key, and then press the second key.

• FIRESTAT menu names, form names, and field names appear in the same 
case as shown on the screen.  For example, a task might instruct you to

1 On the Fire Report menu, click Wildland Fire.

• Topics of special interest or hints that will help you perform a specific 
task show a line before and after the text.  The text appears in italic type.  
For example

For more information about locating an existing fire report, see  
“Searching for fire reports in your local database” in the next section, 
“Viewing, searching for, and printing fire reports.”

How to obtain a copy of this guide
The current version of this guide is available on the US Forest Service site on 
the World Wide Web.  You can print the entire guide or individual chapters.

To print the current version or selected chapters of the FIRESTAT 
User's Guide
1 Log on to your Internet Service Provider.

2 Type www.fs.fed.us/fire/planning/nist in the Address bar, and then press 
ENTER.

3 Scroll down to the bottom of the page, then click Distribution.

4 Click FIRESTAT User's Guide, then follow the instructions on your 
screen.



Chapter 2.  Getting started
This chapter outlines some of the basic information you need to begin using 
FIRESTAT.  Topics include:

• What’s new in FIRESTAT version 5.2
• Navigating through FIRESTAT
• Defining and editing local limits.

What’s new in FIRESTAT 5.2
FIRESTAT version 5.2 is a PC Client/Server software application.  When you 
use FIRESTAT to create and save Individual Fire Reports, the information is 
saved in the Oracle database on your local network server. The fire reports are 
then loaded into the National Fire Management Integrated Database 
(NIFMID), the database for fire occurrence data, at the National Interagency 
Technology Center (NITC).

NIFMID is an Oracle® based relational database.
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Introducing FIRESTAT
FIRESTAT allows you to electronically store the required data on the 
Individual Fire Report, form FS-5100-29.  Once this data is stored in 
NIFMID, you can use the reports at NITC to prepare fire activity summaries 
to meet local, Regional, and National reporting requirements.

Using this information, individual Districts, Forests, Regions, and managers 
at the National level can plan and administer fire management activities, 
monitor and report program performance, and analyze operational fire 
activities.

FIRESTAT verifies data and compares it against your local limits during the 
data entry process and when the transfer file is created.  When you send the 
transfer file to NITC, FIRESTAT verifies the data against valid codes and 
value ranges stored in NIFMID.

You can customize the error checking ability at your site and greatly improve 
the quality of your stored data.  For more information, see “Creating and 
editing local limits,” later in this chapter.

To obtain user support
• Contact your local Regional support group.  To locate this group, check 

with your supervisor and/or computer specialist.

Your Regional support group may also contact the FIRESTAT support
 staff at 1-800-253-5559 or email us at:  

fire_help@dms.nwcg.gov

FIRESTAT access roles
You have one FIRESTAT access role assigned to your Oracle user ID.  An 
access role allows you to see and perform specific FIRESTAT functions on 
the FIRESTAT menu.  These four access roles include:

• Administrator.  Access to all FIRESTAT menus.
• Manager.  Access to all FIRESTAT menus except Role Administration 

on the Action menu.
• Data Entry.  Access to all FIRESTAT menus except Role Administration 

on the Action menu, the Local Limits menu, and the Generate/Transfer 
File menu.

• Reports.  Access to the Query menu, the Reports menu, and Change 
Password on the Action menu.
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To start FIRESTAT 5.2
1 On the Start menu, click Programs, point to F&AM Applications, and 

then click FIRESTAT.

2 In the Logon dialog box, type your Username, your Password, and 
Database name, and then click Connect or press ENTER.

The following diagram shows the Logon dialog box that displays when you 
first log on to FIRESTAT.

Your Username, Password, and Database name are case-sensitive.  Be sure 
to enter this information using the appropriate uppercase and lowercase 
letters.

If you are having trouble logging on or do not know your Username, 
Password, or Database name, contact your local Regional support group.

To log off FIRESTAT
• Press CTRL + q  until you log off.

You can also click Exit on the File menu until the FIRESTAT initial screen 
displays, and then click Exit on the File menu again to exit the FIRESTAT 
program.
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Navigating through the FIRESTAT system
The following diagram outlines some of the elements as they appear on the 
FIRESTAT initial screen.  These terms will be used throughout this 
FIRESTAT User’s Guide.

Using FIRESTAT menus
Each FIRESTAT menu contains one or more menu options or commands that 
allow you to display specific FIRESTAT forms or perform a specific function.  
You can select a menu option or command whenever the FIRESTAT menu bar 
is displayed.

When a menu options appears dimmed, it is unavailable to your access role.  
For more information, see “FIRESTAT access roles,” earlier in this chapter.
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Action menu

The Action menu allows you to perform the following functions:

• change your password
• if authorized, assign access roles.

Fire Report menu

The Fire Report menu allows you to perform the following functions:

• create a wildland fire report
• create the fire report file
• transmit fire report files to NITC
• review transmitted fire report files.

Local Limits menu

The Local Limits menu allows you to customize the error checking available 
in FIRESTAT to your specific site. 
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Query menu

The Query menu allows you to perform the following functions:

• identify and locate specific Wildland Fire reports
• review the Error Log
• review local limits specific for your site.

Reports menu

The Reports menu allows you to print Wildland Fire reports.

Help menu

The Help menu allows you to perform the following functions:

• display informational error messages
• show available function keys
• find out more about this version of FIRESTAT.
2.6 version 5.2 January 10, 2002



Chapter 2. Getting started FIRESTAT User’s Guide
Window menu

The Window menu displays standard Windows-based options.

Navigating through FIRESTAT
This section explains how to display function keys and the field-specific 
index to help you navigate through the FIRESTAT.  Topics include:

• Displaying function keys
• Displaying the index.

Displaying function keys
Function keys allow you to perform many common tasks quickly and easily.  
When you select Show Keys, you can display every function key combination 
currently assigned.  

Show keys is function and menu-specific.  Only the active function keys 
display on the Keys list. 

To show active function keys
• On the Help menu, click Show Keys, or press CTRL + F1.
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The following diagram shows the Show Keys window as it appears while 
displaying the INDIVIDUAL WILDLAND FIRE REPORT.

Displaying the index (List of Values)
In FIRESTAT, an index identifies the possible values for any field in a form 
that has a defined set of entries.  By displaying the index, you can choose 
from the list of values and save typing time.

An index is available for a specific field whenever List of Values displays on 
the status bar.  

To display the index for a specific field on a form
1 Click in the field of your choice.

2 If List of Values displays on the status bar, press F9 or double-click in 
that field.

3 Select the field value of your choice, then click OK to exit the index and 
return to the form.
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The following index displays for the Resource Type field on the 
INDIVIDUAL WILDLAND FIRE REPORT - FMT2.

The index displays only those values that fall within your defined local limits.  
For example, when you display a list of values for county codes, only those 
defined for your site will appear on the list.  For more information, see the next 
section, “Defining and editing local limits.”

Searching for a specific index entry
The percent sign (%) is a wildcard that allows you to narrow your search 
when you are unsure of the exact value, or if the index contains a long list of 
available values.  

To search for specific characters within an index of available 
values
1 Click in the field of your choice.

2 If List of Values displays on the status bar, press F9 or double-click in 
that field.

3 In the Find box, type the first one or two characters of the index entry of 
your choice, type % (the percent sign), and then click Find.

4 Select the field value of your choice, then click OK to exit the index and 
return to the form.
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The following diagram shows a search for all Resource Types that begin with 
the letter “T.”

To display available error information for a completed field
1 Click in the field of your choice.

2 Press SHIFT + F1.

3 To exit the help screen and return to the current FIRESTAT form or menu, 
click OK.

If you are unable to solve the problem using FIRESTAT help information, 
contact your local FIRESTAT system administrator.

Defining and editing local limits
This section explains how to define and print local values and preferences for 
your site.  Before you can create a fire report, you must define your local 
limits.  Defining your local limits includes:

• defining all legal combinations of State, Region, Forests, and Districts
• defining the range of elevation and the latitude and longitude boundaries
• establishing all the weather stations and expected NFDRS fuel models
• identifying counties and wilderness areas.

For example, if you define your assigned Forest with a maximum elevation of 
5000 feet and then create a fire report and enter an elevation greater than 
5000 feet, FIRESTAT will flag that fire report as an error.
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To access a Local Limits form
• On the Local Limits menu, click the local limits form of your choice.

Local Limits toolbar
Toolbar buttons can help you define and edit the local limits for your site.  
You can use these buttons in place of function keys and menu options, or use a 
combination of buttons, function keys and menu options to complete each 
Local Limits form.

The following diagram outlines the functions on the Local Limits toolbar.
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Reporting Units form

Field Description and action to be taken
Enter one line for every legal combination valid for your site.
Unit For every legal combination, type every Region or Unit number that 

your local site handles.
State For every legal combination, type the two-character state postal code 

that your local site handles.
Dist. For every legal combination, type every District number that your 

local site handles.
For example, a unit that has four Districts across two states could 
have up to eight entries.

Elevation Maximum Type the maximum elevation you expect for your local site, in feet 
above sea level.
Mt. McKinley in Alaska is 20,320 feet.  The maximum elevation of 
your unit cannot exceed this number or the maximum elevation for 
the state.

Elevation Minimum Type the minimum elevation you expect for your local site, in feet 
above sea level.
Death Valley’s minimum elevation is -284 feet.  The minimum 
elevation of your unit cannot be less than this number.

For latitude and longitude entries, allow several minutes to account for fires that start outside 
your protection responsibility and either threaten or burn into NFS lands.
Latitude North Deg Type the northernmost latitude just outside your local site, in degrees.
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To complete the Reporting Units form
1 On the Local Limits menu, click Reporting Units.

2 Complete each field as instructed on the previous pages.  Press TAB after 
each entry.

3 When finished, click OK and then click Exit on the File menu, click Exit 
on the Fire Report toolbar, or press CTRL + q.

To delete a reporting unit

You cannot delete a reporting unit that exists on a fire report.

1 On the Local Limits menu, click Reporting Units.

2 On the Local Limits toolbar, click Previous Record and Next Record to 
highlight the Unit of your choice, and then press SHIFT + F6.

3 On the Delete Unit dialog box, click Yes.

4 To save, click OK, and then click Save on the File menu, click Save on 
the Fire Report toolbar, or press F10.

The following diagram shows the Delete Unit dialog box.

Latitude North Min Type the northernmost latitude just outside your local site, in minutes.
Latitude North Sec Type the northernmost latitude just outside your local site, in seconds.
Latitude South Deg Type the southernmost latitude just outside your local site, in degrees.
Latitude South Min Type the southernmost latitude just outside your local site, in minutes. 
Latitude South Sec Type the southernmost latitude just outside your local site, in seconds.
Longitude East Deg Type the easternmost longitude just outside your local site, in degrees.
Longitude East Min Type the easternmost longitude just outside your local site, in 

minutes.
Longitude East Sec Type the easternmost longitude just outside your local site, in 

seconds.
Longitude West Deg Type the westernmost longitude just outside your local site, in 

degrees.
Longitude West Min Type the westernmost longitude just outside your local site, in 

minutes.
Longitude West Sec Type the westernmost longitude just outside your local site, in 

seconds.
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State & Counties form

To define a county to your local site
1 On the Local Limits menu, click Counties.

2 Under Local Use, click every appropriate County check box that you plan 
to use for your local site.

3 When finished, click OK and then click Exit on the File menu, click Exit 
on the Fire Report toolbar, or press CTRL + q.
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Fuel Models form

To add a fuel model to your local site
1 On the Local Limits menu, click Fuel Models.

2 Under Local Use, click every appropriate fuel model check box that you 
plan to use for your local site.

3 When finished, click OK and then click Exit on the File menu, click Exit 
on the Fire Report toolbar, or press CTRL + q.
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Fire Management Zones form

To include Fire Management Zone codes for your local site
1 On the Local Limits menu, click Fire Management Zones.

2 Type the Unit number to be included in your local site.

3 For each Unit number, type the Fmz Code and Fmz Description that you 
will use on your local site.

4 When finished, click OK and then click Exit on the File menu, click Exit 
on the Fire Report toolbar, or press CTRL + q.

To delete a Fire Management Zone code
1 On the Local Limits menu, click Fire Management Zones.

2 On the Local Limits toolbar, click Previous Record and Next Record to 
highlight the Unit of your choice, and then press SHIFT + F6.

3 On the Delete FMZ Code dialog box, click Yes.

4 To save, click OK, and then click Save on the File menu, click Save on 
the Fire Report toolbar, or press F10.
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The following diagram shows the Delete FMZ Code dialog box.

Principal Meridians form

To include a principal meridian code for your local site
1 On the Local Limits menu, click Meridians.

2 Under Local Use, click every appropriate principal meridian code check 
box allowed for your local site.
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3 When finished, click OK and then click Exit on the File menu, click Exit 
on the Fire Report toolbar, or press CTRL + q.

Before you complete this task, see Appendix A, “Codes” to identify the 
principal meridians applicable for your site.  If your Unit is not in the Public 
Lands Survey States, which includes the 13 original colonies and derived 
states, and Texas and Hawaii, do not select any meridian codes.

Weather Stations form

To include a predefined weather station in your local site
1 On the Local Limits menu, click Weather Stations.

2 In the State box, type or select the State of your choice.

3 Under Local Use, click every appropriate weather station check box that 
you plan to use for your local site.

4 When finished, click OK and then click Exit on the File menu, click Exit 
on the Fire Report toolbar, or press CTRL + q.

If the weather station you need does not appear on the list, contact the 
National Fire Applications support staff at 1-800-253-5559.
2.18 version 5.2 January 10, 2002



Chapter 2. Getting started FIRESTAT User’s Guide
To add a new (uncataloged) weather station

You can add a weather station to your local limits to account for a fire report 
that does not identify any particular weather station, or to identify a weather 
station that is not defined.

1 On the Local Limits menu, click Weather Stations.

2 In the State box, type or select the State of your choice, then scroll down 
to the end of the Weather Stations list.

3 On the last line in the first blank row of text boxes, click to select the 
Local Use check box.

4 Complete the Station Code, Description, Station Type, and State text 
boxes, and then click OK.

For example, you can add the station “999999” to define a weather station 
that is “unknown.”

To delete a weather station

You cannot delete a cataloged weather station that is defined in NIFMID or 
one that exists on a fire report.

1 On the Local Limits menu, click Weather Stations.

2 In the State box, type or select the State for the Weather Station of your 
choice.

3 On the Local Limits toolbar, click Previous Record and Next Record to 
highlight the Weather Station of your choice, and then press SHIFT + F6.

4 On the Delete Weather Station dialog box, click Yes.

5 To save, click OK, and then click Save on the File menu, click Save on 
the Fire Report toolbar, or press F10.
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This chapter outlines the information you need to create, edit, and print 
wildland fire reports. Topics include:

• Creating a wildland fire report
• Viewing, searching for, and printing wildland fire reports.

To edit a fire report after you have created the fire report file, see “Correcting 
erroneous fire reports” in Chapter 4, “Generating and transmitting fire reports.”

Creating a wildland fire report
At the minimum, you must complete the following fields to save a fire report 
to the database:

• Region/Forest/District ID and SO Fire Number
• Ownership/State at Origin
• Discovery Date/Time.

The INDIVIDUAL WILDLAND FIRE REPORT consists of five formats:

• FMT1 identifies the name, number, and location of the fire, the agency 
identification, and occurrence information.

• FMT2 identifies the type of action used for initial and final fire 
management actions.

• FMT3 outlines the number of acres burned and a basic description of the 
fire site.

• FMT4 identifies any special codes, additional remarks, and submitted by 
and approved by signatures.

• FMT5 defines up to twenty protection agencies and the number of acres 
that each agency protects.

To access the INDIVIDUAL WILDLAND FIRE REPORT
• On the Fire Report menu, click Wildland Fire.
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Fire Report toolbar
The Fire Report toolbar allows you to perform a variety of functions without 
entering a complex set of commands.

Format buttons
The Fire Report format buttons allow you to easily access each of the five 
INDIVIDUAL WILDLAND FIRE REPORT formats.
3.2 version 5.2 January 10, 2002



Chapter 3. Working with wildland fire reports FIRESTAT User’s Guide
INDIVIDUAL WILDLAND FIRE REPORT - FMT1

Field Description and action to be taken
Status This field identifies the status of the fire report:

• pending
• complete
• failed.

1.  Fire Name Type the assigned name of the fire.
Do not include Dispatch or District number or “fire” as part of the Fire 
Name.  If the assigned name of the fire is greater than 20 characters, 
abbreviate it where possible.

2.  Local Fire Number
(optional)

Type the local number assigned to the fire.
This number is for local purposes only.  It is not retained in the 
NIFMID database.  If directed by your unit, type the District or 
Dispatch fire number here.

3.  Location
(optional)

Type a description of the location, particularly if the fire is not in a 
public land survey State.
Enter the legal location in the Twn/Rge/Sec/SS/Mer field.  The 
Location field is for local purposes only and is not retained in the 
NIFMID database.
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4.  Twn/Rge/Sec/SS/Meri For fires in the 30 public land survey system states, type the township, 
range, section, subsection, and principal meridian to locate the fire 
origin.
Township:

In the first box, type the full township number, a value from 001 
to 199.  Use the following code to denote a full or partial 
township, type the N or S direction.
0 full township (most common)
1 1/4 township (very rare)
2 1/2 township (common in some areas)
3 3/4 township (very rare).
For example, code township 103 1/2 North as “1032N.”

Range:

In the second box, type the range as instructed above in 
“Township,” type the E or W direction.
For example, code range 12 East as “0120E.”

Section:

In the third box, type a section number, a value from 1 to 36.
Subsection:

In the fourth box, type the smallest subdivision first, to the 
nearest quarter section (160 acres) or quarter quarter (40 acres).
For example, code the southwest quarter of the northeast quarter 
as “SWNE.”

Meridian:

In the fifth box, type or select the appropriate principal meridian 
code.

The legal location should correspond directly to the latitude and 
longitude coordinates.

IDENTIFICATION:
5-8.  Region-Forest / District / 
Fire Number
(required)

Type the Region, Forest, and District IDs, and SO Fire Number that 
identify the reporting unit.
Region-Forest:

In the first box, type or select the appropriate Region and Forest 
numbers.

District:

In the second box, type or select the appropriate district number.
SO Fire Number:

In the third box, type the SO fire number, a number from 1 to 
999.

Unless your unit has a compelling local need, the SO Fire Number 
should be the next available consecutive number.  Enter the Dispatch 
number in the Local Fire Number field.
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9.  Protecting Agency at Origin Type or select the appropriate code of the agency that is legally 
responsible to provide primary protection for the land on which the 
fire started.

10-12.  Ownership / State / 
County at origin
(required)

Select the ownership, state, and county at the point of origin.
Ownership:

In the first box, type or select the appropriate ownership status 
code.

State:

In the second box, type or select the appropriate state postal code.
County:

In the third box, type or select the appropriate Federal 
Information Processing System (FIPS) county code.

13.  Fire Management Zone Type the Fire Management Zone (FMZ) in which the fire burned.
If more than one FMZ is involved, enter the FMZ with the most burned 
area.  If the fire burned predominately on non-National Forest land 
that is not in an FMZ, type “9999.”

OCCURRENCE:
14.  Point of Origin-Latitude

Longitude

Type the latitude and longitude at the fire’s point of origin.
Latitude:

In the first box, type the degrees of latitude at the point of origin.  
In the second box, type the minutes of latitude.  In the third box, 
type the seconds of latitude.

Longitude:

In the first box, type the degrees of longitude at the point of 
origin.  In the second box, type the minutes of longitude.  In the 
third box, type the seconds of longitude.

15.  Ignition Date/Time Type the month, day, year, hour, and minute (in military time) when 
the fire started, in the format MM/DD/YYYY HHMI.
If the date and/or time is unknown, enter the best estimate.  Time is a 
value from “0000” (midnight) to “2359.”

15.  Discovery Date/Time
(required)

Type the month, day, year, hour, and minute (in military time) when 
the fire was discovered, in the format MM/DD/YYYY HHMI.
Ignition Date/Time and Discovery Date/Time may be identical.

17.  Detection Method Type or select the appropriate initial detection method code.
Discovered By Type the name of the lookout or person who discovered the fire.
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To complete the INDIVIDUAL WILDLAND FIRE REPORT - FMT1
1 Complete the fields in the form as instructed on the previous pages. 

2 When finished, click FMT2.

18-21.  Statistical /General / 
Specific Cause/ Class People

Select the appropriate statistical, general, specific cause codes, and 
class of people code that best describe the actual cause of the fire.
Statistical:

In the first box, type or select the appropriate statistical cause 
code.

General:

In the second box, type or select the appropriate general cause 
code.

Specific Cause:

In the third box, type or select the appropriate specific cause 
code.

Class People:

In the fourth box, type or select the appropriate class of people 
code.
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INDIVIDUAL WILDLAND FIRE REPORT - FMT2

Field Description and action to be taken
Fire This field is a consecutive number assigned by FIRESTAT.

This field is the Fire ID number that is displayed on FMT1, field 8.
22. (a) Wildland fire used for 
resource benefits

Select this check box if this wildland fire was used for resource 
benefit.

22 (b). Initial Suppression 
Strategy

Click the appropriate option button to identify the initial suppression 
strategy.

23.  Escaped Fire Select the Escaped Fire check box if the fire was declared an escaped 
fire.
Clear the Escaped Fire check box if the planned suppression strategy 
for the fire was achieved by the planned initial action/first 
reinforcement forces.

24.  Initial Action Date/Time Type the month, day, year, hour, and minute (in military time) when 
initial suppression action was started at the site of the fire, in the 
format MM/DD/YYYY HHMI.
Time of Initial Action must be at least one minute after Time of 
Discovery.  For confinement and surveillance fires, enter the time of 
the first surveillance.
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To complete the INDIVIDUAL WILDLAND FIRE REPORT - FMT2
1 Complete the fields in the form as instructed on the previous pages.

2 When finished, click FMT3.

To delete a row of resource information
• In FMT2, click to highlight the Resource Type of your choice, and then 

press SHIFT + F6.

Your changes are saved automatically.

25.  Suppression Strategy 
Attained Date/Time

Type the month, day, year, hour, and minute (in military time) when 
the initial suppression action was achieved, in the format 
MM/DD/YYYY HHMI.
Suppression Strategy Attained Date/Time must be at least one minute 
after Initial Action Date/Time.  For confinement and surveillance fires, 
enter the time of the last surveillance.

If this is an escaped fire, type the date and time the final suppression 
strategy for the escaped fire situation analysis was attained.

26.  Fire Out Date/Time Type the month, day, year, hour, and minute (in military time) when 
the fire was declared out, in the format MM/DD/YYYY HHMI.
Fire Out Date/Time must be at least one minute after Suppression 
Strategy Attained Date/Time. 

27.  Forces Used up to Time of 
Escape or Time Initial Strategy 
Met

Select the resource codes, agencies, and the quantities of the 
suppression forces used up until the initial selected suppression 
strategy was attained.  Complete as many boxes as appropriate to 
adequately describe the forces used.  
Resource Type:

In the first box, type or select the appropriate resource code.
Agency:

In the second box, type or select the appropriate agency.
Quantity:

In the third box, type the quantity of the resource type used.

• Click Add Dup to add a duplicate row of resource information.

If this is an escaped fire, enter the codes for and the quantities of the 
suppression forces used up until the time the fire escaped.

For Incident Command System (ICS) terminology and resource 
module types, refer to Appendix A in the “Fireline Handbook, FSH 
5109.32a.”
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INDIVIDUAL WILDLAND FIRE REPORT- FMT3

Field Description and action to be taken
28.  FFF Cost Type the estimated total emergency Fire Fighting Funds (FFF), in 

whole dollars, expended by the Forest Service as a result of this fire. 
Include G (fires managed for resource benefit) and P (wildland fire) 
codes.

29.  FS Acres (All Forests) Type the total number of acres of National Forest Service lands 
burned on all Forests.

30.  Non-FS Acres Protected by 
FS

Type the number of acres of non-National Forest System lands 
protected by the Forest Service within the fire perimeter.

31.  Non-FS Acres Not Protected 
by FS

Type the number of acres of non-National Forest System lands outside 
Forest Service protection within the fire perimeter.

If the fire involves less than one acre, enter the value to the nearest tenth of one acre.  If the fire involves 
one acre or more, enter the value to the nearest whole acre.  The minimum fire size is 0.1 acre.
32.  Acres Managed for Resource 
Benefit

Type the number of acres burned under prescription using the rules 
that govern wildland fire for resource benefits.
This amount must be less than or equal to the total number of acres 
burned, and will usually be less than or equal to NFS acres.
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To complete the INDIVIDUAL WILDLAND FIRE REPORT - FMT3
1 Complete the fields in the form as instructed on the previous pages.  

2 When finished, click FMT4.

Total Acres Burned This field identifies the total number of acres burned and the 
corresponding fire size class, where:
A identifies fires up to 0.25 acres
B identifies fires from 0.26 to 9.9 acres
C identifies fires from 10 to 99.5 acres
Didentifies fires from 100 to 299 acres
E identifies from 300 to 999 acres
F identifies from 1000 to 4999 acres
G identifies fires greater or equal to 5000 acres.

33.  FMZ NVC per acre Type the average per acre net resource value change (NVC), in whole 
dollars, developed for the National Fire Management Analysis 
System (NFMAS) planning for the Fire Management Zone (FMZ).
Enter damages (losses) as a positive number and benefits as a 
negative number.  Do not recalculate nor include fire effects or NVC 
for this specific fire.  If the fire occurred on non-National Forest and 
the Fire Management Zone is “9999,” enter “0” (zero).

34.  Fire Intensity Level Type or select the appropriate fire intensity level (FIL) code for the 
predominant or typical sustained average flame length observed at the 
head of the fire during the initial attack.

35. Reporting Weather Station Type or select the appropriate six-digit weather station number that 
represents conditions similar to those at the fire site.
The closest weather station may not necessarily represent the fire 
site.

36.  NFDRS Fuel Model Type or select the appropriate one-character code of the prevailing 
NFDRS fuel model where the fire was burning at the same time and 
place where the Fire Intensity Level was observed.

37.  Cover Class Type or select the appropriate two-digit code of the regional 
vegetation cover type where the fire burned during the initial attack.

38.  Aspect Type or select the appropriate general aspect code where the fire was 
burning at the time of initial suppression action.

39.  Slope Percentage Type the slope percent at the fire’s origin, a value from 0 to 150 
percent.

40.  Elevation (feet) Type the elevation, in feet, at the head of the fire at initial action stage.
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INDIVIDUAL WILDLAND FIRE REPORT- FMT4

Field Description and action to be taken
41.  Special Code Type or select the appropriate Special Codes and Values for 

information not recorded elsewhere on the form.  Complete as many 
boxes as appropriate.
Special Code:

In the first box, type or select the appropriate special code.
Value:

In the second box, type or select the value or quantity for that 
special code.

Code Definition:
This field contains the definition of the special code.

42.  Remarks Type any information to clarify and explain the fire situation or 
document additional pertinent facts not recorded elsewhere on the 
form.
Remarks are for local information only and are not stored in the 
NIFMID database.

43.  Submitted By Follow required Forest or Regional instructions for report 
preparation, review, and approval.

44.  Date Type the date the fire report was submitted, in the format 
MMDDYYYY.
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To complete the INDIVIDUAL WILDLAND FIRE REPORT - FMT4
1 Complete the fields in the form as instructed on the previous pages.

2 When finished, click FMT5.

INDIVIDUAL WILDLAND FIRE REPORT- FMT5

FMT5 redisplays the number of acres entered in FMT3 fields 29, “FS Acres 
(All Forests),” 30, “Non-FS Acres Protected by FS,” and 31, “Non-FS Acres 
Not Protected by FS.”  FMT 5 allow you to further define the ownership and/or 
management, in acres for these fields.  You must complete at least one line 
per field.  If you entered an amount in all three fields, you must complete at 
least three lines.

For example, if you entered “1000 acres” in field 29, “NFS Acres (All 
Forests),” and the fire burned on two national forests, complete two lines to 
define the number of acres that burned on each national forest.

45.  Approved By Follow required Forest or Regional instructions for report 
preparation, review, and approval.

46.  Date Type the date the fire report was approved, in the format 
MMDDYYYY.
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To complete the INDIVIDUAL WILDLAND FIRE REPORT - FMT5
1 Complete the fields in the form as instructed on the previous pages.

2 When finished, click Save on the File menu, click Save on the Fire 
Report toolbar, or press F10.

To edit a wildland fire report

To edit a fire report after you have created the fire report file, see “Correcting 
erroneous fire reports” in Chapter 4, “Generating and transmitting fire reports.”

1 On the Fire Report menu, click Wildland Fire.

2 Locate the fire report of your choice.

3 Change the appropriate fields, and then click Save on the File menu, click 
Save on the Fire Report toolbar, or press F10.

For more information about locating fire reports, see the task, “To locate 
the fire report of your choice” in “Using a wildcard to perform a query,” in 
the next section.

Field Description and action to be taken
Prot Agcy For the number of acres specified for fields 29, “FS Acres (All 

Forests),” 30, “Non-FS Acres Protected by FS,” and 31, “Non-FS 
Acres Not Protected by FS,” type or select every agency that provided 
primary fire protection.
• For fires smaller than 100 acres, click Auto Fill.

Land Owner For each identified protection agency, press F9, then click the 
appropriate two or three-character Federal, state, local, or private 
owner group code that owns the land where fire protection was 
provided.
Land Owner may or may not be the same as protection agency.

FS Unit For each protection agency or land owner defined as “USF,” type or 
select the appropriate Region and Forest code where the fire occurred.
For non-Forest Service lands outside NFS protection, leave this field 
blank.

Acres Type the number of acres for each line defined by Prot Agcy, FS Unit, 
and Land Owner fields.
The number of acres cannot be greater than the total number of acres 
specified for fields 29, “NFS Acres (All Forests),” 30, “Non-FS Acres 
Inside,” and 31, “Non-FS Acres Outside.” 
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To delete a wildland fire report
1 On the Fire Report menu, click Wildland Fire.

2 Locate the fire report of your choice.

3 Press SHIFT + F6, and then click Yes on the Delete Fire dialog box.

The following diagram shows the Delete Fire dialog box.

For more information about locating fire reports, see the task, “To locate 
the fire report of your choice” in “Using a wildcard to perform a query,” in 
the next section.

Searching for and printing fire reports
This section explains how to perform basic FIRESTAT utilities, including 
how to perform a query to locate the fire report of your choice and how to 
print a fire report.

Using a wildcard to perform a query
A wildcard query allows you to locate any fire report by simply typing the 
first few characters of a field followed by a percent sign (%).  After executing 
the query, every fire report is reviewed for records that begin with those first 
few characters.  Those fire reports matching the basic criteria are listed in 
consecutive order. 

FIRESTAT is case-sensitive.  Remember to use uppercase and lowercase 
letters as appropriate when you perform queries.

To locate the fire report of your choice
1 From the FIRESTAT initial screen, click Wildland Fire on the Query 

menu.
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2 To locate the fire report of your choice, press F7, click Enter Query on 
the Query menu, or press Query on the Fire Report toolbar.

When you change to Query mode, the fire report form changes from light 
gray to dark gray.

3 In the 1. Fire Name field, type the first one or two characters of the Fire 
Name, and then type % (percent sign).

4 On the Query menu, click Execute Query, press F8, or press Query on 
the Fire Report toolbar.

5 On the Record menu, click Next Record or Previous Record until the 
fire report of your choice displays on your screen.

You can also use the up arrow (↑) and down arrow keys (↓) on your 
keyboard to locate the fire report of your choice.

6 To return to the FIRESTAT initial screen, click Exit on the File menu, 
click Exit on the Fire Report toolbar, or press CTRL + q.

Printing screen captures
You can use the screen capture utility in FIRESTAT to obtain snapshots of 
each INDIVIDUAL WILDLAND FIRE REPORT format.  

To print a screen capture of the fire report of your choice
1 Locate the fire report of your choice, and then click the FMT button of 

your choice.

2 On the Fire Report toolbar, click the Print Screen icon.

3 Complete the dialog boxes as needed.  Be sure to select the appropriate 
printer for your location.
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The following Page Setup dialog box allows you to choose the size and 
orientation of your paper.  You can also click Printer to change the printer 
designation. 

The following dialog box allows you to change the printer designation.

The following Print dialog box allows you to specify how many copies of the 
screen capture you wish to print.
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Chapter 4.  Generating and transmitting fire reports
This chapter outlines the information you need to transmit completed fire 
reports to NITC.  Topics include:

• Setting up your logon ID and password
• Generating the fire report file
• Editing a transmitted fire report
• Correcting erroneous fire reports
• Transmitting fire report files to NITC
• Troubleshooting tips.

Setting up your logon ID and password
Before you begin, you must obtain a WIMS/NIFMID logon ID (LID) and 
password to transmit data to NITC.  You must also synchronize your WIMS/
NIFMID logon ID with your AIX logon ID and password.

To request access to WIMS and the NIFMID database
1 Start your Internet browser.  

2 In the address box, type http://www.fs.fed.us/fire/planning/nist, and 
then click Distribution.

3 Scroll down to Reports/Info/Misc, and then click WIMS Access 
Request form.

You can download this form in either Rich Text Format (.rtf) or in Adobe 
Acrobat format (.pdf).

4 Print the form, then complete and return as instructed.

To access the DCC Password Management form

Before you can transmit fire reports to NITC, your WIMS/NIFMID logon ID and 
password must be defined (or synchronized) to your AIX Logon ID and 
password.

1 Start your Internet browser.

2 In the address box, type

http://fsweb.wo.fs.fed.us/im/utilities/it/dcc/dcc_password.html.
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DCC Password Management form

For more information about completing these fields, contact your local WIMS 
system administrator or the Fire Application Support Desk at 1-800-253-5559.

Field Description and action to be taken
AIX Logon ID Type your AIX logon ID.
AIX Password Type your AIX Password
DCC Hostname Click WIMS.
DCC User ID Type your WIMS/NIFMID logon ID.
New DCC Password Type your WIMS/NIFMID password.
New DCC Password Type your WIMS/NIFMID password.
When to Change Click Now.
Change DCC User ID Click No.
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To synchronize your WIMS/NIFMID logon ID with your AIX logon 
ID and password
• Complete the fields in the form as instructed, then click Submit.

The following message displays after you successfully synchronize your 
WIMS/NIFMID logon ID.

Creating the fire report file
This section explains how to create the fire report file.  First, you must 
designate which fire reports are complete and ready to be included in the fire 
report file.  Next, you will generate the fire report file, which validates each 
fire report for erroneous information.

After generating the fire report file, you must correct any fire reports that failed 
the validation process.  For more information see the next section, “Correcting 
erroneous fire reports.”

To complete the fire reports
1 On the Fire Report menu, click Complete Fires.

2 On the Complete Fires listing, select each check box next to the fire 
report of your choice.  To choose all fire reports, click Select All.

3 Click OK.

4 To return to the FIRESTAT initial screen, click Exit on the File menu, 
click Exit on the Fire Report toolbar, or press CTRL + q.
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The following diagram shows the Complete Fires listing.  From here, you can 
choose to create a fire report file that contains all fire reports on this list, or 
select specific fire reports. 

To generate the fire report file
1 On the Fire Report menu, click Generate/Transfer File.

2 On the Generate/Transfer File dialog box, verify that the Region/Forest 
and Account Number are correct for your local reporting unit, and then 
click Generate File.

The following diagram shows the Generate/Transfer File dialog box and 
sample entries for the Region/Forest, Account Number, and Remark fields.

Be sure that drive J on your personal computer is mapped correctly!
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The following diagram shows the informational message that displays when 
you generate the file.  From here, you can click Yes to continue the generate 
file process, or click No to cancel.

The following diagram shows the confirmation message that appears when 
the fire report file generates successfully.  Be sure to write down the name of 
the transfer filename. 

Editing a transmitted fire report
The section explains how to change the information on a fire report that has 
already been transmitted to NITC.

To edit an already transmitted fire report
1 On the Fire Report menu, click Transmitted Fires.

2 Perform a query to locate the fire report that you want to edit.

For more information about locating fire reports, see the task, “To locate 
the fire report of your choice” in “Using a wildcard to perform a query,” in 
Chapter 3, “Working with wildland fire reports.”

3 Edit the fire report as appropriate.
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4 To save your edits, click Save on the File menu, click Save on the Fire 
Report toolbar, or press F10.

At this point, the status of this fire report is “pending.” To re-transmit this 
fire report, see “Creating a fire report file,” earlier in this chapter.

Correcting erroneous fire reports
The Error Log lists fire reports that failed the validation process when you 
generated the fire report file.  Fire reports are sorted by Region and Forest in 
numerical order.

The following message displays on the Forms dialog box when a fire report 
fails to pass the validation process.

To review a failed fire report
1 On the Query menu, click Error Log.

2 On the Select Report Status menu, click Failed.

3 Select the fire report of your choice, then click Error.

4 To print the list of error messages, click Print Screen on the File menu.

5 To return to the FIRESTAT initial screen, click Exit on the File menu, 
click Exit on the Fire Report toolbar, or press CTRL + q.

The following diagram shows the Select Report Status menu.  From here, you 
can review Pending, Completed, Failed, and Transmitted fire reports.
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The following diagram shows the FIRE STATUS REPORT screen that lists 
failed fire reports.

The following diagram shows the Error Messages for the “Stonehouse” fire 
report. 

To correct errors on a failed fire report
1 On the Fire Report menu, click Wildland Fire.

2 Press F7, and then click Failed on the Status menu.
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3 In the 1. Fire Name field, type the name of the failed fire report and then 
press F8.

For more information about locating fire reports, see the task, “To locate 
the fire report of your choice” in “Using a wildcard to perform a query,” in 
Chapter 3, “Working with wildland fire reports.”

4 On the Status menu, click Pending, and then click Save on the File 
menu, click Save on the Fire Report toolbar, or press F10.

5 Review the Error Log and correct the fire report fields as needed.

6 When finished, click Save on the File menu, click Save on the Fire 
Report toolbar, or press F10.

At this point, correct other erroneous fire reports then return to the section 
“Creating the fire report file” earlier in this chapter.

The following diagram shows “Failed” selected on the Status menu on the 
INDIVIDUAL WILDLAND FIRE REPORT form.

The following diagram shows the failed fire report for the “Orion” fire. 
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The following diagram shows “Pending” selected on the Status menu.

Transmitting fire report files to NITC
This section explains how to transmit a fire report file to NITC.  Before you 
can transmit fire report files you must complete the following sections in this 
chapter:

• Setting up your logon ID and password
• Generating the fire report file
• Correcting erroneous fire reports.

The following naming conventions apply to FIRESTAT fire report files:

To transmit the fire report file
1 On the Fire Report menu, click Generate/Transfer File.

2 On the Generate/Transfer File dialog box, click Transfer File.

3 Type your AIX logon ID and AIX password, and then click OK.

4 On the go.fireload window, type the number that corresponds to the 
transfer file name of your choice, and then press ENTER.

If there are no fire report files that match the “fire###.dat” naming 
convention, the message “No transfer files found” displays on the 
go.fireload window.

5 At the Transmit file at 1800 (6:00 pm) (Y)? prompt, type Y and then 
press ENTER.

To transmit file immediately, type N.  To exit without transmitting, type 1.

6 To return to the go.fireload window, press RETURN, then transmit 
additional fire report files of your choice.

7 When finished, type 1 to exit.

fire###.dat Fire report files that have not been transmitted to 
NIFMID.

fire###.dat.sent Fire report files that have been transmitted to 
NIFMID.

fire333.dat.return.### Output return file.
January 10, 2002 version 5.2 4.9



FIRESTAT User’s Guide Chapter 4. Generating and transmitting fire reports
The following diagram shows the dialog box that displays for logging on to 
the network server.

The following diagram shows the go.fireload window listing two fire report 
files ready to be transmitted and two fire report files that have already been 
transmitted.

You will receive an email message from the IT server when the fire###.dat file 
is successfully submitted to NITC.  If you submitted the fire###.dat file at 1800 
(6:00 pm), you will receive this message sometime after 1800 (6:00 pm).You 
will also receive an email message when the fire report files successfully 
updates the NIFMID database.
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To review return files from NITC
When you receive an email message, “Output from WIMS job FSTW0101 
has been filed in /fsfiles/office/usda/nitc/reports as fire###.data.return.###” 
you can review it for errors, print it, and then delete it from your folder.

1 Open the folder /fsfiles/office/usda/nitc/reports folder on your personal 
computer.

2 Double-click the return file of your choice.

Troubleshooting tips
The following chart outlines some of the problems you may encounter when 
using FIRESTAT version 5.2.

The most current troubleshooting tips are available on the Internet:
http://www.fs.fed.us/fire/planning/nist/firestat.htm#Helpful Hints

If you are still unable to fix the problem, contact FIRE? at 1-800-253-5559.

Problem Solution
I can’t save the fire report. To save a fire report, you must complete at least the following 

fields:
• Region/Forest/District ID
• SO Fire Number
• Ownership/State at Origin
• Discovery Date/Time.

I entered the minimum data, but I still 
can’t save the fire report.

Some of the Specific Cause and Class of People codes, when 
used, keeps FIRESTAT from saving the fire report.
Clear the values in both the Specific Cause and Class People 
fields, and then try saving the report.  If you are still having 
difficulties, contact the Help Desk.

The county code I typed in doesn’t work. You must press CTRL + l and select the appropriate county 
code.

I cannot save the fire report after I 
entered values in the Township and 
Range fields.

FIRESTAT will not save your fire report if you do not 
complete the Township and Range fields as instructed.

I completed and saved a fire report, but 
when I go back into FIRESTAT, I cannot 
find it.

You need to enter Query mode to locate the saved fire report. 
First, press F7 to enter query mode.  Type the search criteria in 
field of your choice.  Press F8 to execute the query.
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Problem Solution
I am unable to transmit the completed fire 
report to NITC.

Be sure to verify the following:
• You must have a valid WIMS/NIFMID logon ID and 

password to transmit to NITC.
• Your AIX logon ID and DCC user ID must be 

synchronized.
• Contact your System Administrator to verify that your PC 

network DNS domain suffixes are set in the correct search 
order.  See OSTIB-2000-14 dated 03-10-2000.

Your network may also be experiencing some problems, or 
WIMS may be down.
The generated transfer files will remain in the /fsfiles/office/
usda/nitc/reports folder.  You can resubmit the transfer file 
once the problem is resolved.
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This appendix contains additional coding information to complete specific 
fields for FS-5100-29.

4.  State and principal meridian codes
Refer to this table when creating and/or editing your local limits.

Code Meridian name State State name
01 1st Principal Meridian IN Indiana
01 1st Principal Meridian OH Ohio
02 2nd Principal Meridian IL Illinois
02 2nd Principal Meridian IN Indiana
03 3rd Principal Meridian IL Illinois
04 4th Principal Meridian IL Illinois
04 4th Principal Meridian MN Minnesota
04 4th Principal Meridian WI Wisconsin
05 5th Principal Meridian AR Arkansas
05 5th Principal Meridian IA Iowa
05 5th Principal Meridian MN Minnesota
05 5th Principal Meridian MO Missouri
05 5th Principal Meridian ND North Dakota
05 5th Principal Meridian SD South Dakota
06 6th Principal Meridian CO Colorado
06 6th Principal Meridian KS Kansas
06 6th Principal Meridian NE Nebraska
06 6th Principal Meridian SD South Dakota
06 6th Principal Meridian WY Wyoming
07 Black Hills SD South Dakota
08 Boise ID Idaho
09 Chicksaw MS Mississippi
10 Choctaw MS Mississippi
11 Cimarron OK Oklahoma
12 Copper River AK Alaska
13 Fairbanks AK Alaska
14 Gila and Salt River AZ Arizona
15 Humbolt CA California
16 Huntsville AL Alabama
January 10, 2002 version 5.2 A.1



FIRESTAT User’s Guide Appendix A. Codes
16 Huntsville MS Mississippi
17 Indian OK Oklahoma
18 Louisiana LA Louisiana
19 Michigan MI Michigan
20 Principal MT Montana
21 Mt. Diablo CA California
21 Mt. Diablo NV Nevada
22 Navajo AZ Arizona
23 New Mexico CO Colorado
23 New Mexico NM New Mexico
24 St. Helena LA Louisiana
25 St. Stephens AL Alabama
25 St. Stephens MS Mississippi
26 Salt Lake UT Utah
27 San Bernardino CA California
28 Seward AK Alaska
29 Tallahassee AL Alabama
29 Tallahassee FL Florida
30 Uintah UT Utah
31 Ute CO Colorado
32 Washington MS Mississippi
33 Willamette WA Washington
34 Wind River WY Wyoming
35 Ohio OH Ohio
36 Great Miami River OH Ohio
37  Muskingum River OH Ohio
38 Ohio River OH Ohio
39 1st Scioto River OH Ohio
40 2nd Scioto River OH Ohio
41 3rd Scioto River OH Ohio
42 Ellicotts Line OH Ohio
43 12 Mile Square OH Ohio
44 Kateel River AK Alaska
45 Umiat AK Alaska
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11. State postal codes
For fires that originate under State, local, or private protection, enter the two-
character postal code.

Code State or other Code State or other
AL Alabama MT Montana
AK Alaska NE Nebraska
AZ Arizona NV Nevada
AR Arkansas NH New Hampshire
CA California NJ New Jersey
CO Colorado NM New Mexico
CT Connecticut NY New York
DE Delaware NC North Carolina
DC District of Columbia ND North Dakota
FL Florida OH Ohio
GA Georgia OK Oklahoma
HI Hawaii PA Pennsylvania
ID Idaho PR Puerto Rico
IL Illinois RI Rhode Island
IN Indiana SC South Carolina
IA Iowa SD South Dakota
KS Kansas TN Tennessee
KY Kentucky TX Texas
LA Louisiana UT Utah
ME Maine VT Vermont
MD Maryland VI Virgin Islands
MA Massachusetts VA Virginia
MX Mexico WA Washington
MI Michigan WV West Virginia
MN Minnesota WI Wisconsin
MS Mississippi WY Wyoming
MO Missouri
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17.  Detection Method
Select the code that corresponds to the initial detection method.

18-21 Statistical/General/Specific Cause/Class of 
People
Statistical Cause

Select the codes that best describe the actual fire cause.

Code Detected by
1 Forest Service Lookout
2 Other Lookout
4 Forest Service Patrol
4 Other Forest Service Employee
5 Planned Cooperator (with who fire control cooperative arrangement exists, 

excluding aircraft)
6 Forest service Permittee (persons holding special use, free use, or grazing 

permits; timber sales and other contracts; their agents and employees)
7 Forest Service Aircraft Observer
8 Other Aircraft Observer
9 Infrared Detection
0 Other

Code Description
1 Lightning
2 Equipment Use
3 Smoking
4 Campfire
5 Debris Burning
6 Railroad
7 Arson
8 Children
9 Miscellaneous
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General Cause
Select the appropriate general cause code to identify the human activity 
related to the fire ignition.  Enter 0 (other) for unknown activities and 
lightning fires.

Specific Cause
Select the appropriate specific cause code to further identify the cause of the 
fire.  Enter 30 (other) for any unknown cause.

Code Description
1 Timber harvest
2 Harvest other products
3 Forest/Range management activities
4 Highway
5 Power, reclamation
6 Hunting
7 Fishing
8 Other recreation
9 Resident
0 Other

Code Description Code Description
01 Lightning 16 Right-of-way burning
02 Aircraft 17 Resource management burning
03 Burning vehicle 18 Grudge fire
04 Exhaust-powersaw 19 Pyromania
05 Exhaust-other 20 Smoking out bees or game
06 Logging line 21 Insect/snake control
07 Brakeshoe 22 Job fire
08 Cooking fire 23 Blasting
09 Warming fire 24 Burning building
10 Smoking 25 Powerline
11 Trash burning 26 Fireworks
12 Burning dump 27 Playing with matches
13 Field burning 28 Repel predatory animals
14 Land clearing 29 Stove fuel sparks
15 Slash burning 30 Other
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Class of People
Select the appropriate class of people code to identify the person or group 
involved with a human-caused fire.  For lightning fires, enter 0 (not person-
caused).  For persons whose status cannot be determined, enter 8 (other).

27.  Forces Used Up to Time of Attainment of Initial 
Strategy or Escape

Select the resource codes, agencies, and the quantities of the suppression 
forces used up until the initial selected suppression strategy was attained.  
Complete as many boxes as appropriate to adequately describe the forces 
used.

Do not enter data or aircraft other than for air tankers and helicopters that 
were used to drop water or retardant.  Note that ICS types do not distinguish 
between permanent tanks and external buckets for helicopters.

List individual components or strike teams.  Do not count personnel who are 
included in an ICS module.  For example, if a D1 code is selected for a type 1 
dozer, do not code the two accompanying personnel as separate individuals.

Select P1 for non-ICS type crews.  Enter the number of persons for each type 
in the quantity field.  If ore forces were used than space permits for data entry, 
consolidate forces by type.  For smoke jumpers, helitack, and rappel 
personnel delivered by aircraft, select P2, P3, or P4 as appropriate.  However, 
for firefighters such as smoke jumpers delivered to a fire by ground vehicle, 
select P1.

Type engines based on tank, size, pump capacity, hoses, and other factors.  
Describe tank size in gallons and pump capacity in gallons per minute, 
separated by a slash.  Select M1 to record water tenders.  Most water tenders 
do not qualify as engines under ICS rules due to pump size, hose capacity, and 
other factors.

Code Description
1 Owner
2 Permittee
3 Contractor
4 Public employee
5 Local permanent
6 Seasonal
7 Transient
8 Other
9 Visitor
0 Not person-caused
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After each Class of Forces code, select F for Forest Service or C for all other 
cooperators, and then enter the quantity.  If the quantity for a single block 
exceeds 99, enter 99.

If no forces were used (confinement/surveillance), enter M1/F/99.

Code Class of Forces ICS Type Unit of Measure Description
A1 Air Tanker 1 each aircraft 3000 gallon
A2 2 1800 gallon
A3 3 600 gallon
A4 4 100 gallon
H1 Helicopter 1 each aircraft 700 gallon
H2 2 300 gallon
H3 3 100 gallon
H4 4 75 gallon
E1 Engine (with crew) 1 each module 1-400 g/1000 gpm
E2 2 2-400 g/500 gpm
E3 3 3-300 g/500 gpm
E4 4 4 4-750 g/70 gpm
E5 5 5-500 g/50 gpm
E6 6 6-200 g/50 gpm
E7 7 7-125 g/20 gpm
E9 Patrol -
D1 Dozer/Plow (with crew) 1 each module 170 HP
D2 2 93 HP
D3 3 65 HP
C1 Crew (Category 1) 1 each crew
C2 Crew (Category 2) 2
P1 Suppression Pers. (Misc.) - each person
P2 Smoke jumper (via para.) -
P3 Helitack (via heli.) -
P4 Rappeller (via heli.) -
M1 Misc., not listed above - not applicable
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28.  FFF Cost
Type the estimated total emergency Fire Fighting Funds (FFF), in whole 
dollars, expended by the Forest Service as a result of this fire.

For a natural prescribed fire that changes to wildfire, include both GG and PP 
costs.

For smaller fires, develop costs based on current wage rates and approximate 
hours charged and equipment contract or use rates.

For project fires, use estimated FFF costs from the final Incident Status 
Summary, form FS-5100-11.

33.  FMZ NVC per Acre (whole $)
Type the average per acre net resource value change (NVC), in whole dollars, 
developed for the National Fire Management Analysis System (NFMAS) 
planning for the Fire Management Zone (FMZ) and the predominant fire 
intensity level in which the fire burned.

Enter damages (losses) as a positive number and benefits as a negative 
number.  Do not recalculate nor include fire effects or NVC for this specific 
fire.  If the fire occurred on non-National Forest and the Fire Management 
Zone is “9999,” enter 0 (zero).

When fire burns significant acreage in each of two or more FMZs, calculate 
and enter a weighted average per acre NVC based on the NFMAS average 
NVC and the acreage burned in each.  Forests that have not developed NVC 
tables for NFMAS must obtain and use NVC data applicable to the area from 
the National Forest(s) that represent them.

34.  Fire Intensity Level
Select the appropriate fire intensity level (FIL) code for the predominant or 
typical sustained average flame length observed at the head of the fire during 
the initial attack.
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36.  NFDRS Fuel Model/Cover Type
NFDRS Fuel Model

Select the appropriate one-character code of the prevailing NFDRS fuel 
model where the fire was burning at the same time and place where the Fire 
Intensity Level was observed.

To designate fires burning in non-vegetative fuels where there is a significant 
separation from wildland fuels, including burning buildings and vehicles on 
paved roadways, select X.

Cover Type
Select the appropriate two-digit code of the regional vegetation cover type 
where the fire burned during the initial attack.

Code Description
A Annual grasses
B Mature brush
C Open pine with grass
D Southern rough
E Hardwood litter (fall)
F Intermountain west brush
G West coast conifers
H Short needle conifers
I Heavy slash
J Intermediate slash
K Light slash
L Perennial grasses
N Saw/march grasses
O High pocosin
P Southern long-needle pine
Q Alaska black spruce
R Hardwood litter (summer)
S Tundra
T Sagebrush with grass
U Western long-leaf pine.
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41. Special Code
Select the appropriate Special Codes for information not recorded elsewhere 
on the form.  Complete as many boxes as appropriate.

Code Definition Description and action to be taken
IG Ignition sites.  The number of multiple 

ignition points within the fire 
perimeter. (optional)

Type the number of separate ignitions that are 
contained within the fire perimeter.
Use this code only when the number of separate 
ignitions is more than one.

PP Fire Accounting Project Code.  PP ties 
the fire report to the FS fire accounting 
code assigned to one or more fires.  
(required for all D class and larger 
fires; recommended for all fires)

Type the five-digit value.  Exclude the leading “P” 
or “R.”
For example, if the accounting code assigned to the 
fire is P71503, select PP, and then type 71503.
Use this code for fires assigned a reimbursable 
account.  Up to four accounting codes are allowed to 
handle situations where several accounting codes 
are used over the life of the fire.  You can also select 
accounting codes for other agencies.

WL Wilderness area.  A fire burning in 
designated wilderness areas.

Select the three-digit wilderness code.
For example, to code a fire in the Bob Marshall 
wilderness area, select WL and then type 049.
Use this code only for fires that occur within 
wilderness boundaries designated by Congress.

ZA Fire size when declared a wildfire.  
The fire size in acres when a 
prescribed natural fire was declared a 
wildfire.

Type the fire size in whole acres when the 
prescribed fire was declared a wildfire.
For example, if a fire was 0.4 acres, type 0 (zero).  If 
the fire was 1023 acres, type 1023.  If a fire was 
greater than 99,999 acres, type 99999.

ZC Date declared contained.  The month 
and day a prescribed fire (either 
natural or management ignited) was 
declared contained.

Type the two-digit month and two-digit-day the fire 
was contained, in the format MMDD.  The default 
time is “1200.”
For example, if a fire was contained on August 19th, 
type 0819.  The year is determined using other data 
fields.

ZD Total resource damage in ten thousand 
dollar increments.  The total resource 
damage on National Forest System 
Lands determined by analysis.

Type the total resource damage determined by 
analysis, in $10,000 increments.
For example, if a fire damages $4,999 in resources, 
type 0 (zero).  If a fire damaged $10,000,000 type 
1000.  The maximum codable value is $999.99 
million, types as 99999.
Use this code only for large fires that have 
significant resource damage.
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Do not substitute local codes for the national codes defined in this section.  
National codes are defined so that local units can collect data in a consistent 
manner.

To define special codes for Regional or local use, send a definition of the code 
and related values to your national FIRESTAT support personnel to 
fire_help@dms.nwcg.gov.

ZW Data declared wildfire.  The month and 
day a prescribed fire (either natural or 
management ignited) was declared a 
wildfire.

Type the two-digit month and two-digit-day the fire 
was contained, in the format MMDD.  The default 
time is “1200.”
For example, if a fire was declared a wildfire on 
August 19th, type 0819.  The year is determined 
using other data fields.
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County codes by state
The county codes below are listed in alphabetical order by state.
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For State Code = 01 - Alabama
State County County Name State County County Name
AL 001 Autauga AL 069 Houston
AL 003 Baldwin AL 071 Jackson
AL 005 Barbour AL 073 Jefferson
AL 007 Bibb AL 075 Lamar
AL 009 Blount AL 077 Lauderdale
AL 011 Bullock AL 079 Lawrence
AL 013 Butler AL 081 Lee
AL 015 Calhoun AL 083 Limestone
AL 017 Chambers AL 085 Lowndes
AL 019 Cherokee AL 087 Macon
AL 021 Chilton AL 089 Madison
AL 023 Choctaw AL 091 Nfarengo
AL 025 Clarke AL 093 Marion
AL 027 Clay AL 095 Marshall
AL 029 Cleburne AL 097 Mobile
AL 031 Coffee AL 099 Monroe
AL 033 Colbert AL 101 Montgomery
AL 035 Conecuh AL 103 Morgan
AL 037 Coosa AL 105 Perry
AL 039 Covington AL 107 Pickens
AL 041 Crenshaw AL 109 Pike
AL 043 Cullman AL 111 Randolph
AL 045 Dale AL 113 Russell
AL 047 Dallas AL 115 Saint Clair
AL 049 De Kalb AL 117 Shelby
AL 051 Elmore AL 119 Sumter
AL 053 Escambia AL 121 Talladega
AL 055 Etowah AL 123 Tallapoosa
AL 057 Fayette AL 125 Tuscaloosa
AL 059 Franklin AL 127 Walker
AL 061 Geneva AL 129 Washington
AL 063 Greene AL 131 Wilcox
AL 065 Hale AL 133 Winston
AL 067 Henry
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For State Code = 02 - Alaska 

For State Code = 04 - Arizona 

For State Code = 05 - Arkansas 

State County County Name State County County Name 
AK 013 Aleutians East AK 170 Matanuska-Susitna
AK 016 Aleutians West AK 180 Nome
AK 020 Anchorage AK 185 North Slope
AK 050 Bethel AK 188 Northwest Artic
AK 060 Bristol Bay AK 201 Prince of Wales-Oute
AK 070 Dillingham AK 220 Sitka
AK 090 Fairbanks North Star AK 231 Skagway-Yakutat-Ango
AK 100 Haines  AK 240 Southeast Fairbanks
AK 110 Juneau  AK 261 Valdez-Cordova
AK 122 Kenai Peninsula AK 270 Wade Hampton 
AK 130 Ketchikan Gateway AK 280 Wrangell-Petersburg
AK 150 Kodiak Island AK 290 Yukon-Koyukuk
AK 164 Lake and Peninsula

State County County Name State County County Nome
AZ 001 Apache AZ 015 Mohave
AZ 003 Cochise AZ 017 Navajo
AZ 005 Coconino  AZ 019 Pima
AZ 007 Gila AZ 021 Pinal
AZ 009 Graham  AZ 023 Santa Cruz
AZ 011 Greenlee  AZ 025 Yavapai
AZ 012 La Paz AZ 027 Yuma
AZ 013 Maricopa

State County County Name State County County Name
AR 001 Arkansas AR 077 Lee 
AR 003 Ashley AR 079 Lincoln
AR 005 Baxter AR 081 Little River
AR 007 Benton AR 083 Logan
AR 009 Boone AR 085 Lonoke
AR 011 Bradley AR 087 Madison
AR 013 Calhoun AR 089 Marion
AR 015 Carroll AR 091 Miller
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AR 017 Chicot AR 093 Mississippi
AR 019 Clark AR 095 Monroe
AR 021 Clay AR 097 Montgomery
AR 023 Cleburne AR 099 Nevada
AR 025 Cleveland AR 101 Newton
AR 027 Columbia AR 103 Ouachita
AR 029 Conway AR 105 Perry
AR 031 Craighead AR 107 Phillips
AR 033 Crawford AR 109 Pike
AR 035 Crittenden AR 111 Poinsett
AR 037 Cross AR 113 Polk
AR 039 Dallas AR 115 Pope
AR 041 Desha AR 117 Praine
AR 043 Drew AR 119 Pulaski
AR 045 Faulkner AR 121 Randolph
AR 047 Franklin AR 123 Saint Francis
AR 049 Fulton AR 125 Saline
AR 051 Garland AR 127 Scott 
AR 053 Grant AR 129 Searcy
AR 055 Greene AR 131 Sebastian
AR 057 Hempstead AR 133 Sevier
AR 059 Hot Spring AR 135 Sharp
AR 061 Howard AR 137 Stone
AR 063 Independence AR 139 Union
AR 065 Izard AR 141 Van Buren
AR 067 Jackson AR 143 Washington
AR 069 Jefferson AR 145 White
AR 071 Johnson AR 147 Woodruff
AR 073 Lafayette AR 149 Yell
AR 075 Lawrence
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For State Code = 06 - California 
State County County Name State County County Name
CA 001 Alameda CA 059 Orange
CA 003 Alpine CA 061 Placer 
CA 005 Amador CA 063 Plumas
CA 007 Butte CA 065 Riverside
CA 009 Calaveras CA 067 Sacramento
CA 011 Colusa CA 069 San Benito
CA 013 Contra Costa CA 071 San Bernardino
CA 015 Del Norte CA 073 San Diego 
CA 017 El Dorado CA 075 San Francisco
CA 019 Fresno CA 077 San Joaquin 
CA 021 Glenn CA 079 San Luis Obispo
CA 023 Humboldt CA 081 San Mateo 
CA 025 Imperial CA 083 Santa Barbara
CA 027 Inyo CA 085 Santa Clara
CA 029 Kern CA 087 Santa Cruz
CA 031 Kings CA 089 Shasta
CA 033 Lake CA 091 Sierra 
CA 035 Lassen CA 093 Siskiyou.
CA 037 Los Angeles CA 095 Solano 
CA 039 Madera CA 097 Sonoma 
CA 041 Marin CA 099 Stanislaus
CA 043 Mariposa CA 101 Sutter
CA 045 Mendocino CA 103 Tehama
CA 047 Merced CA 105 Trinity
CA 049 Modoc CA 107 Tulare
CA 051 Mono CA 109 Tuolumne
CA 053 Monterey CA 111 Ventura
CA 055 Napa CA 113 Yolo
CA 057 Nevada CA 115 Yuba 
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For State Code = 08 - Colorado 
State County County Name State County County Name
CO 001 Adams CO 065 Lake
CO 003 Alamosa CO 067 La Plata
CO 005 Arapahoe CO 069 Larimer
CO 007 Archuleta CO 071 Las Animas
CO 009 Baca CO 073 Uncoln
CO 011 Bent CO 075 Logan
CO 013 Boulder CO 077 Mesa 
CO 015 Chaffee CO 079 Mineral
CO 017 Cheyenne CO 081 Moffat
CO 019 Clear Creek CO 083 Montezuma
CO 021 Conejos CO 085 Montrose
CO 023 Costilla CO 087 Morgan
CO 025 Crowley CO 089 Otero
CO 027 Custer CO 091 Ouray
CO 029 Delta CO 093 Park
CO 031 Denver CO 095 Phinips
CO 033 Dolores CO 097 Pitkin 
CO 035 Douglas CO 099 Prowers
CO 037 Eagle CO 101 Pueblo 
CO 039 Elbert CO 103 Rio Blanco 
co 041 El Paso CO 105 Rio Grande
CO 043 Fremont CO 107 Routt
CO 045 Garfield CO 109 Saguache
CO 047 Gilpin CO 111 San Juan 
CO 049 Grand CO 113 San Miguel
CO 051 Gunnison CO 115 Sedgwick
CO 053 Hinsdale CO 117 Summit
CO 055 Huerfano CO 119 Teller
CO 057 Jackson CO 121 Washington
CO 059 Jefferson CO 123 Weld
CO 061 Kiowa CO 125 Yuma
CO 063 Kit Carson
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For State Code = 09 - Connecticut 

For State Code = 10 - Delaware 

For State Code = 11 - Washington, D.C. 

For State Code = 12 - Florida 

State County County Name State County County Name
CT 001 Fairfield CT 009 New Haven
CT 003 Hartford CT 011 New London
CT 005 Litchfield CT 013 Tolland 
CT 007 Middlesex CT 015 Windham 

State County County Name State County County Name
DE 001 Kent DE 005 Sussex
DE 003 New Castle 

State County County Name State County County Name
DC 001 District of Columbia

State County County Name State County County Name
FL 001 Alachua FL 069 Lake
FL 003 Baker FL 071 Lee
FL 005 Bay FL 073 Leon
FL 007 Bradford FL 075 Levy
FL 009 Brevard FL 077 Liberty
FL 011 Broward FL 079 Madison
FL 013 Calhoun FL 081 Manatee
FL 015 Charlotte FL 083 Marion
FL 017 Citrus FL 085 Martin
FL 019 Clay FL 087 Monroe
FL 021 Collier FL 089 Nassau
FL 023 Columbia FL 091 Okaloosa
FL 025 Dade FL 093 Okeechobee
FL 027 De Soto FL 095 Orange
FL 029 Dixie FL 097 Osceola
FL 031 Duval FL 099 Palm Beach
FL 033 Escambia FL 101 Pasco
FL 035 Flagler FL 103 Pinellas
FL 037 Franklin FL 105 Polk
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FL 039 Gadsden FL 107 Putnam
FL 041 Gilchrist FL 109 Saint Johns
FL 043 Glades FL 111 Saint Lucie
FL 1045 Gulf FL 113 Santa Rosa
FL 047 Hamilton FL 115 Sarasota
FL 049 Hardee FL 117 Seminole
FL 051 Hendry FL 119 Sumter
FL 053 Hernando FL 121 Suwannee
FL 055 Highlands FL 123 Taylor
FL 057 Hillsborough FL 123 Union
FL 059 Holmes FL 127 Volusia
FL 061 Indian River FL 129 Wakulla
FL 063 Jackson FL 131 Walton
FL 065 Jefferson FL 133 Washington
FL 067 Lafayette
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For State Code = 13 - Georgia
State County County Name State County County Name
GA 001 Appling GA 163 Jefferson
GA 003 Atkinson GA 165 Jenkins
GA 005 Bacon GA 167 Johnson
GA 007 Baker GA 169 Jones
GA 009 Baldwin GA 171 Lamar
GA 011 Banks GA 173 Lanier 
GA 013 Barrow GA 175 Laurens
GA 015 Bartow GA 177 Lee
GA 017 Ben Hill GA 179 Liberty
GA 019 Berrien GA 181 Lincoln
GA 021 Bibb GA 183 Long
GA 023 Bleckley GA 185 Lowndes
GA 025 Brantley GA 187 Lumpkin
GA 027 Brooks GA 189 McDuffie
GA 029 Bryan GA 191 McIntosh
GA 031 Bulloch GA 193 Macon
GA 033 Burke GA 195 Madison
GA 035 Butts GA 197 Marion
GA 037 Calhoun GA 199 Meriwether
GA 039 Camden GA 201 Miller
GA 043 Candler GA 205 Mitchell
GA 045 Carroll GA 207 Monroe
GA 047 Catoosa GA 209 Montgomery
GA 049 Chariton GA 211 Morgan
GA 051 Chatham GA 213 Murray
GA 053 Chattahoochee GA 215 Muscogee
GA 055 Chattooga GA 217 Newton
GA 057 Cherokee GA 219 Oconee
GA 059 Clarke GA 221 Oglethorpe
GA 061 Clay GA 223 Paulding
GA 063 Clayton GA 225 Peach
GA 065 Clinch GA 227 Pickens
GA 067 Cobb GA 229 Pierce
GA 069 Coffee GA 231 Pike
GA 071 Colquitt GA 233 Polk
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GA 073 Columbia GA 235 Pulaski
GA 075 Cook GA 237 Putnam
GA 077 Coweta GA 239 Quitman
GA 079 Crawford GA 241 Rabun
GA 081 Crisp GA 243 Randolph 
GA 083 Dade GA 245 Richmond
GA 085 Dawson GA 247 Rockdale
GA 087 Decatur GA 249 Schley
GA 089 DeKalb GA 251 Screven
GA 091 Dodge GA 253 Seminoie
GA 093 Dooly GA 255 Spalding
GA 093 Dougherty GA 257 Stephens
GA 097 Douglas GA 259 Stewart
GA 099 Early GA 261 Sumter
GA 101 Echols GA 263 Talbot 
GA 103 Effingham GA 265 Taliaferro
GA 105 Elbert GA 267 Tattnall
GA 107 Emanuel GA 269 Taylor
GA 109 Evans GA 271 Telfair
GA 111 Fannin GA 273 Terrell
GA 113 Fayette GA 275 Thomas
GA 115 Floyd GA 277 Tift
GA 117 Forsyth GA 279 Toombs
GA 119 Franklin GA 281 Towns
GA 121 Fulton GA 283 Treutlen
GA 123 Gilmer GA 285 Troup
GA 125 Glascock GA 287 Turner
GA 127 Glynn GA 289 Twiggs
GA 129 Gordon GA 291 Union
GA 131 Grady GA 293 Upson
GA 133 Greene GA 295 Walker
GA 135 Gwinnett GA 297 Walton
GA 137 Habersham GA 299 Ware
GA 139 Hall GA 301 Warren
GA 141 Hancock GA 303 Washington
GA 143 Haralson GA 305 Wayne
GA 145 Harris GA 307 Webster
GA 147 Hart GA 309 Wheeler
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GA 149 Heard GA 311 White
GA 151 Henry GA 313 Whitfield
GA 153 Houston GA 315 Wilcox
GA 155 Irwin GA 317 Wilkes 
GA 157 Jackson GA 319 Wilkinson
GA 159 Jasper GA 321 Worth
GA 161 Jeff Davis
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For State Code = 15 - Hawaii

For State Code = 16 - Idaho 

For State Code = 17 - Illinois 

State County County Name State County County Name
HI 001 Hawaii HI 007 Kauai
HI 003 Honolulu HI 009 Maui
HI 005 Kalawao

State County County Name State County County Name
ID 001 Ada ID 045 Gem
ID 003 Adams ID 047 Gooding
ID 005 Bannock ID 049 Idaho
ID 007 Bear Lake ID 051 Jefferson
ID 009 Benewah ID 053 Jerome
ID 011 Bingham ID 055 Kootenai
ID 013 Blaine ID 057 Latah
ID 015 Boise ID 059 Lemhi
ID 017 Bonner ID 061 Lewis
ID 019 Bonneville ID 063 Lincoln
ID 021 Boundary ID 065 Madison
ID 023 Butte ID 067 Minidoka
ID 025 Camas ID 069 Nez Perce
ID 027 Canyon ID 071 Oneida
ID 029 Caribou ID 073 Owyhee
ID 031 Cassia ID 075 Payette
ID 033 Clark ID 077 Power
ID 035 Clearwater ID 079 Shoshone
ID 037 Custer ID 081 Teton
ID 039 Elmore ID 083 Twin Falls
ID 041 Franklin ID 085 Valley
ID 043 Fremont ID 087 Washington

State County County Name State County County Name
IL 001 Adams IL 103 Lee
IL 003 Alexander IL 105 Livingston
IL 005 Bond  IL 107 Logan
IL 007 Boone IL 109 McDonough
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IL 009 Brown IL 111 McHenry
IL 011 Bureau IL 113 McLean
IL 013 Calhoun IL 115 Macon
IL 015 Carroll IL 117 Macoupin
IL 017 Cass IL 119 Madison
IL 019 Champaign IL 121 Marion
IL 021 Christian IL 123 Marshall
IL 023 Clark IL 125 Mason
IL 025 Clay  IL 127 Massac
IL 027 Clinton IL 129 Menard
IL 029 Coles IL 131 Mercer
IL 031 Cook  IL 133 Monroe
IL 033 Crawford IL 135 Montgomery
IL 035 Cumberland IL 137 Morgan
IL 037 De Kalb IL 139 Moultrie
IL 039 De Witt IL 141 Ogle
IL 041 Douglas IL 143 Peoria
IL 043 Du Page IL 145 Perry
IL 045 Edgar IL 147 Piatt
IL 047 Edwards IL 149 Pike
IL 049 Effingham IL 151 Pope
IL 051 Fayette IL 153 Pulaski
IL 053 Ford IL 155 Putnam
IL 055 Franklin IL 157 Randolph
IL 057 Fulton IL 159 Richland
IL 059 Gallatin IL 161 Rock Island
IL 061 Greene IL 163 Saint Clair
IL 063 Grundy IL 165 Saline
IL 065 Hamilton IL 167 Sangamon
IL 067 Hancock IL 169 Schuyler
IL 069 Hardin IL 171 Scott
IL 071 Henderson IL 173 Shelby
IL 073 Henry IL 175 Stark
IL 075 Iroquois IL 177 Stephenson
IL 077 Jackson IL 179 Tazewell
IL 079 jasper IL 181 Union
IL 081 Jefferson IL 183 Vermilion
IL 083 Jersey IL 185 Wabash
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IL 085 Jo Daviess IL 187 Warren
IL 087 Johnson IL 189 Washington
IL 089 Kane IL 191 Wayne
IL 091 Kankakee IL 193 White
IL 093 Kendall IL 195 Whiteside
IL 095 Knox IL 197 Will
IL 097 Lake IL 199 Williamson
IL 099 La Salle IL 201 Winnebago
IL 101 Lawrence IL 203 Woodford
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For State Code = 18 - Indiana 
State County County Name State County County Name
IN 001 Adams IN 093 Lawrence
IN 003 Allen N 095 Madison
IN 005 Bartholomew IN 097 Marion
IN 007 Benton IN 099 Marshall
IN 009 Blackford N 101 Martin
IN 011 Boone IN 103 Miami
IN 013 Brown IN 105 Monroe
IN 015 Carroll N 107 Montgomery
IN 017 Cass IN 109 Morgan
IN 019 Clark IN 111 Newton
IN 021 Clay IN 113 Noble
IN 023 Clinton  IN 115 Ohio
N 025 Crawford IN 117 Orange
IN 027 Daviess  IN 119 Owen
IN 029 Dearborn IN 121 Parke
IN 031 Decatur  IN 123 Perry
IN 033 De Kalb IN 125 Pike
IN 035 Delaware IN 127 Porter
IN 037 Dubois IN 129 Posey
IN 039 Elkhart IN 131 Pulaski
IN 041 Fayette IN 133 Putnam
IN 043 Floyd IN 135 Randolph
IN 045 Fountain IN 137 Ripley
IN 047 Franklin IN 139 Rush
IN 049 Fulton IN 141 Saint Joseph
IN 051 Gibson IN 143 Scott
IN 053 Grant IN 145 Shelby
IN 055 Greene N 147 Spencer
IN 057 Hamilton IN 149 Starke
IN 059 Hancock  IN 151 Steuben
IN 061 Harrison IN 153 Sullivan
IN 063 Hendricks IN 155 Switzerland
IN 065 Henry IN 157 Tippecanoe
IN 067 Howard IN 159 Tipton
IN 069 Huntington IN 161 Union
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IN 071 Jackson IN 163 Vanderburgh
IN 073 Jasper IN 165 Vermillion
IN 075 Jay IN 167 Vigo
N 077 Jefferson IN 169 Wabash
IN 079 Jennings IN 171 Warren
IN 081 Johnson IN 173 Warrick
IN 083 Knox N 17 Washington
IN 085 Kosciusko IN 177 Wayne
IN 087 Lagrange IN 179 Wells
IN 089 Lake IN 181 White
IN 091 La Porte IN 183 Whitley 
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For State Code = 19 - Iowa
State County County Name State County County Name
IA 001 Adair IA 101 Jefferson
IA 003 Adams IA 103 Johnson
IA 005 Allamakee IA 105 Jones
IA 007 Appanoose IA 107 Keokuk
IA 009 Audubon IA 109 Kossuth
IA 011 Benton IA 111 Lee
IA 013 Black Hawk IA 113 Linn
IA 015 Boone IA 115 Louisa
IA 017 Bremer IA 117 Lucas
IA 019 Buchanan IA 119 Lyon
IA 021 Buena Vista IA 121 Madison
IA 023 Butler IA 123 Mahaska
IA 025 Calhoun IA 125 Marion
IA 027 Carroll IA 127 Marshall
IA 029 Cass IA 129 Mills
IA 031 Cedar IA 131 Mitchell
IA 033 Cerro Gordo IA 133 Monona
IA 035 Cherokee IA 135 Monroe
IA 037 Chickasaw IA 137 Montgomery
IA 039 Clarke IA 139 Muscatine
IA 041 Clay IA 141 O'Brien
IA 043 Clayton IA 143 Osceola
IA 045 Clinton IA 145 Page
LA 047 Crawford IA 147 Palo Alto
IA 049 Dallas  IA 149 Plymouth
IA 051 Davis IA 151 Pocahontas
IA 053 Decatur IA 153 Polk
IA 055 Delaware IA 155 Pottawattamie
IA 057 Des Moines IA 157 Poweshiek
IA 059 Dickinson IA 159 Ringgold
IA 061 Dubuque IA 161 Sac
IA 063 Emmet IA 163 Scott
IA 065 Fayette IA 165 Shelby
IA 067 Floyd IA 167 Sioux
IA 069 Franklin IA 169 Story
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IA 071 Fremont IA 171 Tama
IA 073 Greene IA 173 Taylor
IA 075 Grundy IA 175 Union 
IA 077 Guthrie IA 177 Van Buren
IA 079 Hamilton IA 179 Wapello
IA 081 Hancock IA 181 Warren 
IA 083 Hardin IA 183 Washington
IA 085 Harrison IA 185 Wayne
IA 087 Henry IA 187 Webster
IA 089 Howard IA 189 Winnebago
IA 091 Humboldt IA 191 Winneshiek
IA 093 Ida IA 193 Woodbury
IA 095 Iowa IA 195 Worth
IA 097 Jackson IA 197 Wright
IA 099 Jasper
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For State Code = 20 - Kansas 
State County County Name State County County Name
KS 001 Allen KS 107 Linn
KS 003 Anderson KS 109 Logan
KS 005 Atchison KS 111 Lyon
KS 007 Barber KS 113 McPherson
KS 009 Barton  KS 115 Manon
KS 011 Bourbon KS 117 Marshall
KS 013 Brown KS 119 Meade
KS 015 Butler KS 121 Miami
KS 017 Chase KS 123 Mitchell
KS 019 Chautauqua KS 125 Montgomery
KS 021 Cherokee KS 127 Morris
KS 023 Cheyenne KS 129 Morton
KS 025 Clark KS 131 Nemaha
KS 027 Clay KS 133 Neosho
KS 029 Cloud -KS 135 Ness
KS 031 Coffey  KS 137 Norton
KS 033 Comanche KS 139 Osage
KS 035 Cowley  KS 141 Osborne
KS 037 Crawford KS 143 Ottawa
KS 039 Decatur KS 145 Pawnee
KS 041 Dickinson KS 147 Phillips
KS 043 Doniphan KS 149 Pottawatomie
KS 045 Douglas KS 151 Pratt
KS 047 Edwards KS 153 Rawlins
KS 049 Elk KS 155 Reno
KS 051 Ellis KS 157 Republic
KS 033 Ellsworth KS 159 Rice
KS 055 Finney KS 161 Riley
KS 057 Ford KS 163 Rook.
KS 059 Franklin KS 165 Rush
KS 061 Geary KS 167 Russell
KS 063 Gove KS 169 Saline
KS 065 Graham KS 171 Scott 
KS 067 Grant KS 173 Sedgwick
KS 069 Gray KS 175 Seward
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KS 071 Greeley KS 177 Shawnee
KS 073 Greenwood KS 179 Sheridan
KS 075 Hamilton KS 181 Sherman
KS 077 Harper KS 183 Smith
KS 079 Harvey KS 183 Stafford
KS 081 Haskell KS 187 Stanton
KS 083 Hodgeman KS 189 Stevens
KS 085 Jackson KS 191 Sumner
KS 087 Jefferson KS 193 Thomas
KS 089 Jewell KS 195 Trego
KS 091 Johnson KS 197 Wabaunsee
KS 093 Kearny KS 199 Wallace
KS 095 Kingman KS 201 Washington
KS 097 Kiowa KS 203 Wichita
KS 099 Labette KS 205 Wilson
KS 101 Lane KS 207 Woodson
KS 103 Leavenworth KS 209 Wyandotte
KS 105 Lincoln
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For State Code = 21 - Kentucky
State County County Name State County County Name
KY 001 Adair KY 121 Knox
KY 003 Allen KY 123 Larue
KY 005 Anderson KY 125 Laurel
KY 007 Ballard KY 127 Lawrence
KY 009 Barren KY 129 Lee
KY 011 Bath KY 131 Leslie
KY 013 Bell KY 133 Letcher
KY 015 Boone KY 135 Lewis
KY 017 Bourbon KY 137 Lincoln 
KY 019 Boyd KY 139 Livingston
KY 021 Boyle KY 141 Logan
KY 023 Bracken KY 143 Lyon
KY 025 Breathitt KY 145 McCracken
KY 027 Breckinridge KY 147 McCreary
KY 029 Bullitt KY 149 McLean
KY 031 Butler KY 151 Madison
KY 033 Caldwell KY 153 Magoffin
KY 035 Calloway KY 155 Manon
KY 037 Campbell KY 157 Marshall
KY 039 Carlisle KY 159 Martin
KY 041 Carroll KY 161 Mason
KY 043 Carter KY 163 Meade 
KY 045 Casey KY 165 Menifee
KY 047 Christian KY 167 Mercer
KY 049 Clark KY 169 Metcalfe
KY 051 Clay KY 171 Monroe
KY 053 Clinton KY 173 Montgomery
KY 055 Crittenden KY 175 Morgan
KY 057 Cumberland KY 177 Muhlenberg
KY 059 Daviess KY 179 Nelson 
KY 061 Edmonson KY 181 Nicholas
KY 063 Elliott KY 183 Ohio
KY 065 Estill KY 185 Oldham
KY 067 Fayette KY 187 Owen
KY 069 Fleming KY 189 Owsley 
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For State Code = 22 - Louisiana 

KY 071 Floyd KY 191 Pendleton
KY 073 Franklin KY 193 Perry
KY 075 Fulton KY 195 Pike
KY 077 Gallatin KY 197 Powell
KY 079 Garrard KY 199 Pulaski 
KY 081 Grant KY 201 Robertson
KY 083 Graves KY 203 Rockcastle
KY 085 Grayson KY 205 Rowan
KY 087 Green KY' 207 Russell
KY 089 Greenup KY 209 Scott
KY 091 Hancock KY 211 Shelby
KY 093 Hardin KY 213 Simpson
KY 095 Harlan KY 215 Spencer
KY 097 Harrison KY 217 Taylor
KY 099 Hart KY 219 Todd
KY 101 Henderson KY 221 Trigg 
KY 103 Henry KY 223 Trirnble
KY 105 Hickman KY 225 Union
KY 107 Hopkins KY 227 Warren
KY 109 Jackson KY 229 Washington
KY 111 Jefferson KY 231 Wayne
KY 113 Jessamine KY 233 Webster
KY 115 Johnson KY 235 Whitley
KY 117 Kenton KY 237 Wolfe
KY 119 Knott KY 239 Woodford

State County County Name State County County Name
LA 001 Acadia LA 065 Madison
LA 003 Allen LA 067 Morehouse
LA 005 Ascension LA 069 Natchitoches
LA 007 Assumption LA 071 Orleans
LA 009 Avoyelles LA 073 Ouachita
LA 011 Beauregard LA 075 Plaquemines
LA 013 Bienville LA 077 Pointe Coupee
LA 015 Bossier LA 079 Rapides
LA 017 Caddo LA 081 Red River
LA 019 Calcasieu LA 083 Richland
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LA 021 Caldwell LA 085 Sabine
LA 023 Cameron LA 087 Saint Bernard
LA 025 Catahoula LA 089 Saint Charles
LA 027 Claiborne LA 091 Saint Helena
LA 029 Concordia LA 093 Saint James
LA 031 De Soto LA 095 Saint John the Baptist
LA 033 East Baton Rouge LA 097 Saint Landry
LA 035 East Carroll LA 099 Saint Martin
LA 037 East Feliciana LA 101 Saint Mary
LA 039 Evangeline LA 103 Saint Tammany
LA 041 Franklin LA 105 Tangipahoa
LA 043 Grant LA 107 Tensas
LA 045 Iberia LA 109 Terrebonne
LA 047 Iberville LA 111 Union
LA 049 Jackson LA 113 Vermilion
LA 051 Jefferson LA 115 Vernon
LA 053 Jefferson Davis LA 117 Washington
LA 055 Lafayette LA 119 Webster
LA 057 Lafourche LA 121 West Baton Rouge
LA 059 La Salle LA 123 West Carroll
LA 061 Lincoln LA 125 West Feliciana
LA 063 Livingston LA. 127 Winn
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For State Code = 23 - Maine 

For State Code = 24 - Maryland

For State Code = 25 - Massachusetts

State County County Name State County County Name
ME 001 Androscoggin ME 017 Oxford 
ME 003 Aroostook ME 019 Penobscot
ME 005 Cumberland ME 021 Piscataguis
ME 007 Franklin ME 023 Sagadahoc
ME 009 Hancock ME 025 Somerset
ME 011 Kennebec ME 027 Waldo
ME 013 Knox ME 029 Washington
ME 115 Lincoln  ME 031 York

State County County Name State County County Name
MD 001 Allegany MD 027 Howard
NM 003 Anne Arundel MD 029 Kent
MD 005 Baltimore MD 031 Montgomery
MD 009 Calvert MD 033 Prince Georges
MD 011 Caroline MD 035 Queen Annes
MD 013 Carroll MD 037 Saint Marys
MD 015 Cecil MD 039 Somerset
MD 017 Charles MD 041 Talbot
MD 019 Dorchester MD 043 Washington
MD 021 Frederick MD 045 Wicomico
MD 023 Garrett MD 047 Worcester
MD 025 Harford MD 510 Baltimore City

State County County Name State County County Name
MA 001 Barnstable MA 015 Hampshire
MA 003 Berkshire MA 017 Middlesex
MA 005 Bristol MA 019 Nantucket
MA 007 Dukes MA 021 Norfolk 
MA 009 Essex MA 023 Plymouth
MA 011 Franklin MA 025 Suffolk
MA 013 Hampden NlA 027 Worcester
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For State Code = 26 - Michigan 
State County County Name State County County Name
MI 001 Alcona MI 085 Lake 
MI 003 Alger MI 087 Lapeer 
MI 005 Allegan MI 089 Leelanau
MI 007 Alpena ml 091 Lenawee
MI 009 Antrim MI 093 Livingston
MI 011 Arenac MI 095 Luce
MI 013 Baraga MI 097 Mackinac
MI 015 Bany  ml 099 Macomb
MI 017 Bay MI 101 Manistee
MI 019 Benzie MI 103 Marquette
MI 021 Berrien MI 105 Mason
MI 023 Branch MI 107 Mecosta
MI 025 Calhoun MI 109 Menominee
MI 027 Cass MI 111 Midland
MI 029 Charlevoix MI 113 Nessaukee
MI 031 Cheboygan MI 115 Monroe
MI 033 Chippewa MI 117 Montcahn
MI 035 Clare MI 119 Montmorency
MI 037 Clinton MI 121 Muskegon
MI 039 Crawford MI 123 Newaygo
MI 041 Delta MI 125 Oakland
MI 043 Dickinson MI 127 Oceana
MI 045 Eaton MI 129 Ogemaw
MI 047 Emmet MI 131 Ontonagon
MI 049 Genesee MI 133 Osceola
MI 051 Gladwin MI 135 Oscoda
MI 053 Gogebic MI 137 Otsego
MI 055 Grand Traverse MI 139 Ottawa
MI 057 Gratiot MI 141 Presque Isle
MI 059 Hillsdale MI 143 Roscommon
MI 061 Houghton MI 145 Saginaw
MI 063 Huron MI 147 Saint Clair
MI 065 Ingham MI 149 Saint Joseph
MI 067 lonia MI 131 Sanilac
MI 069 losco ml 133 Schoolcraft
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MI 071 Iron MI 155 Shiawassee
MI 073 Isabella MI 157 Tuscola
MI 075 Jackson  ml 159 Van Buren
MI 077 Kalamazoo MI 161 Washtenaw
MI 079 Kalkaska MI 163 Wayne
MI 081 Kent MI 165 Wexford
MI 083 Keweenaw
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For State Code = 27 - Minnesota 
State County County Name State County County Name
MN 001 Aitkin MN 089 Marshall
MN 003 Anoka MN 091 Martin
MN 005 Becker MN 093 Meeker
MN 007 Beltrami MN 095 Mille Lacs
MN 009 Benton MN 097 Morrison
MN 011 Big Stone MN 099 Mower
MN 013 Blue Earth MN 101 Murray
MN 015 Brown MN 103 Nicollet
MN 017 Carlton MN 105 Nobles
NW 019 Carver MN 107 Norman
MN 021 Cass MN 109 Olmsted
MN 023 Chippewa MN 111 Otter Tail 
MN 025 Chisago MN 113 Pennington
MN 027 Clay MN 113 Pine
MN 029 Clearwater MN 117 Pipestone
MN 031 Cook MN 119 Polk
MN 033 Cottonwood MN 121 Pope
MN 035 Crow Wing MN 123 Ramsey 
MN 037 Dakota MN 125 Red Lake
MN 039 Dodge MN 127 Redwood
MN 041 Douglas MN 129 Renville
MN 043 Faribault MN 131 Rice
MN 045 Fillmore MN 133 Rock
NN 047 Freeborn MN 135 Roseau
MN 049 Goodhue MN 137 Saint Louis
MN 051 Grant MN 139 Scott
MN 053 Hennepin MN 141 Sherburne
MN 055 Houston MN 143 Sibley
NN 057 Hubbard MN 145 Steams
MN 059 Isanti MN 147 Steele
MN 061 Itasca NN 149 Stevens 
MN 063 Jackson MN 151 Swift
MN 065 Kanabec MN 153 Todd
MN 067 Kandiyohi MN 155 Traverse
MN 069 Kittson MN 157 Wabasha
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MN 071 Koochiching MN 159 Wadena
MN 073 Lac Qui Parie- MN 161 Waseca
MN 075 Lake MN 163 Washington
MN 077 Lake of the Woods MN 165 Watonwan
MN 079 Le Sueur MN 167 Wilkin
MN 081 Lincoln MN 169 Winona
MN 083 Lyon MN 171 Wright
MN 085 McLeod MN 173 Yellow Medicine
MN 087 Mahnomen
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For State Code = 28 - Mississippi 
State County County Name State County County Name 
MS 001 Adams MS 083 Leflore
MS 003 Alcom MS 085 Lincoln
Ms 005 Amite MS 087 Lowndes
MS 007 Attala MS 089 Madison
MS 009 Benton MS 091 Marion
MS 011 Bohvar MS 093 Marshall
MS 013 Calhoun MS 095 Monroe
MS 015 Carroll MS 097 Montgomery
MS 017 Chickasaw MS 099 Neshoba
MS 019 Choctaw MS 101 Newton
MS 021 Claiborne MS 103 Noxubee 
MS 023 Clarke MS 105 Oktibbeha
MS 025 Clay MS 107 Panola
MS 027 Coahoma MS 109 Pearl River
MS 029 Copiah MS 111 Perry
MS 031 Covington MS 113 Pike
MS 033 De Soto MS 115 Pontotoc
MS 035 Forrest MS 117 Prentiss
MS 037 Franklin MS 119 Quitma
MS 039 George MS 121 Rankin
MS 041 Greene MS 123 Scott
MS 043 Grenada MS 125 Sharke
MS 045 Hancock MS 127 Simpson
MS 047 Harrison MS 129 Smith
MS 049 Hinds MS 131 Stone
MS 051 Holmes MS 133 Sunflower
MS 053 Humphreys MS 135 Tallahatchie
MS 055 Issaguena MS 137 Tate
Ms 057 Itawamba MS 139 Tippah
Ms 059 Jackson MS 141 Tishomingo
MS 061 Jasper MS 143 Tunica
MS 063 Jefferson MS 145 Union
MS 065 Jefferson Davis MS 147 Walthall
MS 067 Jones MS 149 Warren
MS 069 Kemper MS 151 Washington
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MS 071 Lafayette MS 153 Wayne
MS 073 Lamar MS 155 Wester
MS 075 Lauderdale MS 157 Wilkinson
MS 077 Lawrence MS 159 Winston
MS 079 Leake MS 161 Yalobusha
MS 081 Lee MS 163 Yazoo
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For State Code = 29 - Missouri
State County County Name State County County Name
MO 001 Adair MO 117 Livingston
MO 003 Andrew MO 119 McDonald
MO 005 Atchison MO 121 Macon
MO 007 Audrain MO 123 Madison
MO 009 Barry MO 125 Maries
MO 011 Barton MO 127 Marion
MO 013 Bates MO 129 Mercer
MO 015 Benton MO 131 Miller
MO 017 Bollinger MO 133 Mississippi
MO 019 Boone MO 135 Moniteau
MO 021 Buchanan MO 137 Monroe
MO 023 Butler MO 139 Montgomery
MO 025 Caldwell MO 141 Morgan
MO 027 Callaway MO 143 New Madrid
MO 029 Camden MO 145 Newton 
MO 031 Cape Girardeau MO 147 Nodaway
MO 033 Carroll MO 149 Oregon
MO 035 Carter MO 151 Osage
MO 037 Cass MO 153 Ozark
MO 039 Cedar MO 155 Perniscot
MO 041 Chariton MO 157 Perry
MO 043 Christian MO 159 Pettis
MO 045 Clark MO 161 Phelps
MO 047 Clay MO 163 Pike
MO 049 Clinton MO 165 Platte
MO 051 Cole MO 167 Polk
MO 053 Cooper MO 169 Pulaski
MO 055 Crawford MO 171 Putnam
MO 057 Dade MO 173 Ralls
MO 059 Dallas MO 175 Randolph
MO 061 Daviess MO 177 Ray
MO 063 De Kalb MO 179 Reynolds
MO 065 Dent MO 181 Ripley
MO 067 Douglas MO 183 Saint Charles
MO 069 Dunklin MO 185 Saint Clair
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MO 071 Franklin MO 186 Sainte Genevieve
MO 073 Gasconade MO 187 Saint Francois
MO 075 Gentry MO 189 Saint Louis
MO 077 Creene MO 195 Saline
MO 079 Grundy MO 197 Schuyler
MO 081 Harrison MO 199 Scotland
MO 083 Henry MO 201 Scott
MO 085 Hickory MO 203 Shannon
MO 087 Holt MO 205 Shelby
MO 089 Howard MO 207 Stoddard
MO 091 Howell MO 209 Stone
MO 093 Iron MO 211 Sullivan
MO 095 Jackson MO 213 Taney
MO 097 Jasper MO 215 Texas
MO 099 Jefferson MO 217 Vernon
MO 101 Johnson MO 219 Warren
MO 103 Knox MO 221 Washington
MO 105 Laclede MO 223 Wayne
MO 107 Lafayette MO 225 Webster
MO 109 Lawrence MO 227 Worth
MO 111 Lewis MO 229 Wright
MO 113 Lincoln MO 310 Saint Louis City
MO 115 Linn
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For State Code = 30 - Montana 

For State Code = 31 - Nebraska 

State County County Name State County County Name
MT 001 Beaverhead MT 059 Meagher
MT 003 Big Horn MT 061 Mineral
MT 005 Blaine MT 063 Missoula
MT 007 Broadwater MT 065 Musselshell
MT 009 Carbon  MT 067 Park
MT 011 Carter  MT 069 Petroleum
MT 013 Cascade MT 071 Phillips
MT 015 Chouteau MT 073 Pondera
MT 017 Custer MT 075 Powder River
MT 019 Daniels MT 077 Powell
MT 021 Dawson MT 079 Prairie
MT 023 Deer Lodge MT 081 Ravalli
MT 025 Fallon MT 083 Richland 
MT 027 Fergus MT 085 Roosevelt
MT 029 Flathead MT 087 Rosebud
MT 031 Gallatin w 089 Sanders
MT 033 Garfield MT 091 Sheridan
MT 035 Glacier MT 093 Silver Bow
MT 037 Golden Valley MT 095 Stillwater
MT 039 Granite MT 097 Sweet Grass
MT 041 Hill MT 099 Teton
MT 043 Jefferson MT 101 Toole 
MT 045 Judith Basin MT 103 Treasure
MT 047 Lake MT 105 Valley
MT 049 Lewis And Clark MT 107 Wheatland
MT 051 Liberty MT 109 Wibaux
MT 053 Lincoln MT 111 Yellowstone
MT 055 McCone MT 113 Yellowstone Natl Park
MT 057 Madison

State County County Name State County County Name
NE 001 Adams NE 095 Jefferson
NE 003 Antelope NE 097 Johnson
NE 005 Arthur NE 099 Kearney
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NE 007 Banner NE 101 Keith
NE 009 Blaine NE 103 Keya Paha
NE 011 Boone NE 105 Kimball
NE 013 Box Butte NE 107 Knox 
NE 015 Boyd NE 109 Lancaster
NE 017 Brown NE 111 Lincoln
NE 019 Buffalo NE 113 Logan
NE 021 Burt NE 115 Loup 
NE 023 Butler NE 117 McPherson
NE 025 Cass NE 119 Madison
NE 027 Cedar NE 121 Merrick
NE 029 Chase NE 123 Morrill
NE 031 Cherry NE 125 Nance 
NE 033 Cheyenne NE 127 Nemaha
NE 035 Clay NE 129 Nuckolls
NE 037 Colfax NE 131 Otoe 
NE 039 Cuming NE 133 Pawnee
NE 041 Custer NE 135 Perkins
NE 043 Dakota NE 137 Phelps
NE 045 Dawes NE 139 Pierce
NE 047 Dawson NE 141 Platte
NE 049 Deuel NE 143 Polk 
NE 051 Dixon NE 145 Red Willow
NE 053 Dodge NE 147 Richardson
NE 055 Douglas NE 149 Rock 
NE 057 Dundy NE 151 Saline
NE 059 Fillmore NE 153 Sarpy
NE 061 Franklin NE 155 Saunders
NE 063 Frontier NE 157 Scotts Bluff
NE 065 Furnas NE 159 Seward 
NE 067 Gage NE 161 Sheridan
NE 069 Garden NE 163 Sherman
NE 071 Garfield NE 165 Sioux
NE 073 Gosper NE 167 Stanton
NE 075 Grant NE 169 Thayer 
NE 077 Greeley NE 171 Thomas 
NE 079 Hall NE 173 Thurston
NE 081 Hamilton NE 175 Valley
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For State Code = 32 - Nevada

For State Code = 33 - New Hampshire

For State Code = 34 - New Jersey

NE 083 Harlan NE 177 Washington
NE 085 Hayes NE 179 Wayne
NE 087 Hitchcock NE 181 Webster
NE 089 Holt NE 183 Wheeler
NE 091 Hooker NE 185 York
NE 093 Howard

State County County Name State County County Name
NV 001 Churchill NV 019 Lyon
NV 003 Clark NV 021 Nffneral
NV 005 Douglas NV 023 Nye 
NV 007 Elko NV 027 Pershing
NV 009 Esmeralda NV 029 Storey
NV 011 Eureka NV 031 Washoe
NV 013 Humboldt NV 033 White Pine
NV 015 Lander NV 510 Carson City
NV 017 Lincoln

State County County Name State County County Name
NH 001 Belknap NH 011 Hillsborough
NH 003 Carroll NH 013 Merrimack
NH 005 Cheshire NH 015 Rockingham
NH 007 Coos NH 017 Strafford
NH 009 Grafton NH 019 Sullivan

State County County Name State County County Name
NJ 001 Atlantic NJ 023 Middlesex
NJ 003 Bergen NJ 025 Monmouth
NJ 005 Burlington NJ 027 Morris
NJ 007 Camden NJ 029 Ocean
NJ 009 Cape May NJ 031 Passaic
NJ 011 Cumberland NJ 033 Salem
NJ 013 Essex NJ 035 Somerset
NJ 015 Gloucester NJ 037 Sussex
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NJ 017 Hudson NJ 039 Union
NJ 019 Hunterdon NJ 041 Warren
NJ 021 Mercer
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For State Code = 35 - New Mexico

For State Code = 36 - Now York 

State County County Name State County County Name
NM 001 Bernalillo NM 031 McKinley
NM 003 Catron NM 033 Mora
NM 005 Chaves NM 035 Otero
NM 006 Cibola NM 037 Quay
NM 007 Colfax NM 039 Rio Arriba
NM 009 Curry NM 041 Roosevelt
NM 011 De Baca NM 043 Sandoval
NM 013 Dona Ana NM 045 San Juan
NM 015 Eddy NM 047 San Miguel
NM 017 Grant NM 049 Santa Fe
NM 019 Guadalupe NM 051 Sierra
NM 021 Harding NM 053 Socorro
NM 023 Hidalgo NM 055 Taos
NM 025 Lea NM 057 Torrance
NM 027 Lincoln NM 059 Union 
NM 028 Los Alamos NM 061 Valencia 
NM 029 Luna

State County County Name State County County Name
NY 001 Albany NY 063 Niagara
NY 003 Allegany NY 065 Oneida
NY 005 Bronx NY 067 Onondaga
NY 007 Broome NY 069 Ontario
NY 009 Cattaraugus NY 071 Orange
NY 011 Cayuga NY 073 Orleans
NY 013 Chautauqua NY 075 Oswego
NY 015 Chemung NY 077 Otsego
NY 017 Chenango NY 079 Putnam
NY 019 Clinton NY 081 Queens 
NY 021 Columbia NY 083 Rensselaer
NY 023 Cortland NY 085 Richmond
NY 025 Delaware NY 087 Rockland 
NY 027 Dutchess NY 089 Saint Lawrence
NY 029 Erie NY 091 Saratoga
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NY 031 Essex NY 093 Schenectady
NY 033 Franklin NY 095 Schoharie
NY 035 Fulton NY 097 Schuyler
NY 037 Genesee NY 099 Seneca 
NY 039 Greene NY 101 Steuben
NY 041 Hamilton NY 103 Suffolk
NY 043 Herkimer NY 105 Sullivan
NY 045 Jefferson NY 107 Tioga
NY 047 Kings NY 109 Tompkins
NY 049 Lewis NY 111 Ulster
NY 051 Livingston NY 113 Warren
NY 053 Madison NY 115 Washington
NY 055 Monroe NY 117 Wayne
NY 057 Montgomery NY 119 Westchester
NY 059 Nassau NY 121 Wyoming
NY 061 New York NY 123 Yates
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For State Code = 37 - North Carolina 
State County County Name State County County Name
NC 001 Alamance NC 101 Johnston
NC 003 Alexander NC 103 Jones
NC 005 Alleghany NC 105 Lee
NC 007 Anson NC 107 Lenoir
NC 009 Ashe NC 109 Lincoln
NC 011 Avery NC 111 McDowell
NC 013 Beaufort NC 113 Macon
NC 015 Bertie NC 115 Madison
NC 017 Bladen NC 117 Martin
NC 019 Brunswick NC 119 Mecklenburg
NC 021 Buncombe NC 121 Mitchell 
NC 023 Burke NC 123 Montgomery
NC 025 Cabarrus NC 125 Moore
NC 027 Caldwell NC 127 Nash 
NC 029 Camden NC 129 New Hanover
NC 031 Carteret NC 131 Northampton
NC 033 Caswell NC 133 Onslow
NC 035 Catawba NC 135 Orange
NC 037 Chatham NC 137 Pamlico
NC 039 Cherokee NC 139 Pasquotank
NC 041 Chowan NC 141 Pender
NC 043 Clay NC 143 Perquimans
NC 045 Cleveland NC 145 Person
NC 047 Columbus NC 147 Pitt
NC 049 Craven NC 149 Polk
NC 051 Cumberland NC 151 Randolph
NC 053 Currituck NC 153 Richmond
NC 055 Dare NC 155 Robeson
NC 057 Davidson NC 157 Rockingham
NC 059 Davie NC 159 Rowan
NC 061 Duplin NC 161 Rutherford
NC 063 Durham NC 163 Sampson 
NC 065 Edgecombe NC 165 Scotland
NC 067 Forsyth NC 167 Stanly
NC 069 Franklin NC 169 Stokes
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NC 071 Gaston NC 171 Surry
NC 073 Gates NC 173 Swam
NC 075 Graham NC 175 Transylvania
NC 077 Granville NC 177 Tyrrell
NC 079 Greene NC 179 Union
NC 081 Guilford NC 181 Vance
NC 083 Halifax NC 183 Wake
NC 085 Harnett -NC 185 Warren
NC 087 Haywood NC 187 Washington
NC 089 Henderson NC 189 Watauga
NC 091 Hertford NC 191 Wayne
NC 093 Hoke NC 193 Wilkes
NC 095 Hyde NC 119 Wilson
NC 097 Iredell NC 197 Yadkin
NC 099 Jackson NC 199 Yancey
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For State Code = 38 - North Dakota 

For State Code = 39 - Ohio

State County County Name State County County Name
ND 001 Adams ND 055 McLean
ND 003 Barnes ND 057 Mercer
ND 005 Benson ND 059 Morton
ND 007 Billings ND 061 Mountrail
ND 009 Bottineau ND 063 Nelson
ND 011 Bowman ND 065 Oliver
ND 013 Burke ND 067 Pembina
ND 015 Burleigh ND 069 Pierce 
ND 017 Cass ND 071 Ramsey
ND 019 Cavalier ND 073 Ransom
ND 021 Dickey ND 075 Renville
ND 023 Divide ND 077 Richland
ND 025 Dunn ND 079 Rolette
ND 027 Eddy ND 081 Sargent
ND 029 Emmons ND 083 Sheridan
ND 031 Foster ND 085 Sioux
ND 033 Golden Valley ND 087 Slope
ND 035 Grand Forks ND 089 Stark
ND 037 Grant ND 091 Steele
NI) 039 Griggs ND 093 Stutsman
ND 041 Hettinger ND 095 Towner
ND 043 Kidder ND 097 Traill
ND 045 La Moure ND 099 Walsh
ND 047 Logan ND 101 Ward
ND 049 McHenry ND 103 Wells
ND 051 McIntosh ND 105 Williams
ND 053 McKenzie

State County County Name State County County Name
OH 001 Adams OH 089 Licking
OH 003 Allen OH 091 Logan
OH 005 Ashland OH 093 Lorain
OH 007 Ashtabula OH 095 Lucas
OH 009 Athens OH 097 Madison
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OH 011 Auglaize OH 099 Mahoning
OH 013 Belmont OH 101 Manon
OH 015 Brown OH 103 Medina
OH 017 Butler OH 105 Meigs
OH 019 Carroll OH 107 Mercer
OH 021 Champaign OH 109 Miami
OH 023 Clark OH 111 Monroe
OH 025 Clermont OH 113 Montgomery
OH 027 Clinton OH 115 Morgan
OH 029 Columbiana OH 117 Morrow
OH 031 Coshocton OH 119 Muskingum
OH 033 Crawford OH 121 Noble 
OH 035 Cuyahoga OH 123 Ottawa
OH 037 Darke OH 125 Paulding
OH 039 Defiance OH 127 Perry 
OH 041 Delaware OH 129 Pickaway
OH 043 Erie OH 131 Pike
OH 045 Fairfield OH 133 Portage
OH 047 Fayette OH 135 Preble
OH 049 Franklin OH 137 Putnam
OH 051 Fulton OH 130 Richland
OH 053 Gallia OH 141 Ross
OH 055 Geauga OH 143 Sandusky
OH 057 Greene OH 145 Scioto
OH 059 Guernsey OH 147 Seneca 
OH 061 Hamilton OH 149 Shelby
OH 063 Hancock OH 151 Stark 
OH 065 Hardin OH 153 Summit
OH 067 Harrison OH 155 Trumbull 
OH 069 Henry OH 157 Tuscarawas
OH 071 Highland OH 159 Union 
OH 073 Hocking OH 161 Van Wert
OH 075 Holmes OH 163 Vinton
OH 077 Huron OH 165 Warren
OH 079 Jackson OH 167 Washington
OH 081 Jefferson OH 169 Wayne
OH 083 Knox OH 171 Williams
OH 085 Lake OH 173 Wood 
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OH 087 Lawrence OH 175 Wyandot
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For State Code = 40 - Oklahoma 
State County County Name State County County Name
OK 001 Adair OK 079 Le Flore
OK 003 Alfalfa OK 081 Lincoln
OK 005 Atoka OK 083 Logan
OK 007 Beaver OK 085 Love
OK 009 Beckham OK 087 McClain
OK 011 Blaine OK 089 McCurtain
OK 013 Bryan OK 091 McIntosh
OK 015 Caddo OK 093 Major
OK 017 Canadian OK 095 Marshall
OK 019 Carter OK 097 Mayes
OK 021 Cherokee OK 099 Murray
OK 023 Chactaw OK 101 Muskogee
OK 025 Cimarron OK 103 Noble
OK 027 Cleveland OK 105 Nowata
OK 029 Coal OK 107 Okfuskee
OK 031 Comanche OK 109 Oklahoma
OK 033 Cotton OK 111 Okmulgee
OK 035 Craig OK 113 Osage
OK 037 Creek OK 115 Ottawa
OK 039 Custer OK 117 Pawnee
OK 041 Delaware OK 119 Payne
OK 043 Dewey OK 121 Pittsburg
OK 045 Ellis OK 123 Pontotoc 
OK 047 Garfield  OK 125 Pottawatomie
OK 049 Garvin OK 127 Pushmataha
OK 051 Grady OK 129 Roger Mills
OK 053 Grant OK 131 Rogers 
OK 055 Greer OK 133 Seminole
OK 057 Harmon OK 135 Sequoyah
OK 059 Harper OK 137 Stephens
OK 061 Haskell OK 139 Texas 
OK 063 Hughes OK 141 Tillman
OK 065 Jackson OK 143 Tulsa
OK 067 Jefferson OK 145 Wagoner 
OK 069 Johnston OK 147 Washington
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OK 071 Kay OK 149 Washita
OK 073 Kingfisher OK 151 Woods
OK 075 Kiowa OK 153 Woodward
OK 077 Latimer
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For State Code = 41 - Oregon 

For State Code = 42 - Pennsylvania 

State County County Name State County County Name
OR 001 Baker OR 037 Lake
OR 003 Benton OR 039 Lane 
OR 005 Clackamas OR 041 Lincoln
OR 007 Clatsop OR 043 Linn
OR 009 Columbia OR 045 Malheur
OR 011 Coos OR 047 Marion 
OR 013 Crook OR 049 Morrow
OR 015 Curry OR 051 Multnomah
OR 017 Deschutes OR 053 Polk 
OR 019 Douglas OR 035 Sherman 
OR 021 Gilliam OR 057 Tillamook
OR 023 Grant OR 059 UmatiHa
OR 025 Hamey OR 061 Union 
OR 027 Hood River OR 063 Wallowa
OR 029 Jackson OR 065 Wasco
OR 031 Jefferson OR 067 Washington
OR 033 Josephine OR 069 Wheeler
OR 035 Klamath OR 071 Yamhill

State County County Name State County County Name
PA 001 Adams PA 069 Lackawanna
PA 003 Allegheny PA 071 Lancaster
PA 005 Armstrong PA 073 Lawrence
PA 007 Beaver PA 075 Lebanon
PA 009 Bedford PA 077 Lehigh
PA 011 Berks PA 079 Luzerne
PA 013 Blair PA 081 Lycoming
PA 015 Bradford PA 083 McKean
PA 017 Bucks PA 085 Mercer
PA 019 Butler PA 087 Mifflin
PA 021 Cambria PA 089 Monroe 
PA 023 Cameron PA 091 Montgomery
PA 025 Carbon PA 093 Montour
PA 027 Centre PA 095 Northampton
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For State Code = 44 - Rhode Island 

For State Code = 45 - South Carolina 

PA 029 Chester PA 097 Northumberland
PA 031 Clarion PA 099 Perry
PA 033 Clearfield PA 101 Philadelphia
PA 035 Clinton PA 103 Pike
PA 037 Columbia PA 105 Potter
PA 039 Crawford PA 107 Schuylkill
PA 041 Cumberland PA 109 Snyder
PA 043 Dauphin PA 111 Somerset 
PA 045 Delaware PA 113 Sullivan 
PA 047 Elk PA 115 Susquehanna
PA 049 Erie PA 117 Tioga
PA 051 Fayette PA 119 Union
PA 053 Forest PA 121 Venango
PA 055 Franklin PA 123 Warren
PA 057 Fulton PA 125 Washington
PA 059 Greene PA 127 Wayne
PA 061 Huntingdon PA 129 Westmoreland
PA 063 Indiana PA 131 Wyoming
PA 065 Jefferson PA 133 York
PA 067 Juniata

State County County Name State County County Name 
RI 001 Bristol RI 007 Providence
RI 003 Kent RI 009 Washington
RI 005 Newport

State County County Name State County County Name 

SC 001 Abbeville SC 047 Greenwood
SC 003 Aiken SC 049 Hampton
SC 005 Allendale SC 051 Horry
SC 007 Anderson SC 053 Jasper
SC 009 Bamberg SC 055 Kershaw
SC 011 Barnwell SC 057 Lancaster
SC 013 Beaufort SC 059 Laurens
SC 015 Berkeley SC 061 Lee
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SC 017 Calhoun SC 063 Lexington
SC 019 Charleston SC 065 McCormick
SC 021 Cherokee SC 067 Marion
SC 023 Chester SC 069 Marlboro
SC 025 Chesterfield SC 071 Newberry
SC 027 Clarendon SC 073 Oconee
SC 029 Colleton SC 075 Orangeburg
SC 031 Darlington SC 077 Pickens
SC 033 Dillon SC 079 Richland
SC 035 Dorchester SC 081 Saluda
SC 037 Edgefield SC 083 Spartanburg
SC 039 Fairfield SC 085 Sumter
SC 041 Florence SC 087 Union
SC 043 Georgetown SC 089 Williamsburg
SC 045 Greenville SC 091 York 
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For State Code = 46 - South Dakota 
State County County Name State County County Name
SD 001 Armstrong SD 069 Hyde
SD 003 Aurora SD 071 Jackson
SD 005 Beadle SD 073 Jerauld
SD 007 Bennett  SD 075 Jones 
SD 009 Bon Homme SD 077 Kingsbury
SD 011 Brookings SD 079 Lake 
SD 013 Brown SD 081 Lawrence
SD 015 Brule SD 083 Lincoln
SD 017 Buffalo  SD 085 Lyman 
SD 019 Butte SD 087 McCook
SD 021 Campbell SD 089 McPherson
SD 023 Charles Mix SD 091 Marshall
SD 025 Clark SD 093 Meade
SD 027 Clay SD 095 Mellette
SD 029 Codington SD 097 Miner
SD 031 Corson SD 099 Minnehaha
SD 033 Custer SD 101 Moody 
SD 035 Davison SD 103 Pennington 
SD 037 Day SD 105 Perkins
SD 039 Deuel SD 107 Potter
SD 041 Dewey SD 109 Roberts
SD 043 Douglas SD 111 Sanborn
SD 045 Edmunds SD 113 Shannon
SD 047 Fall River SD 115 Spink
SD 049 Faulk SD 117 Stanley
SD 051 Grant SD 119 Sully
SD 053 Gregory SD 121 Todd
SD 055 Haakon SD 123 Tripp
SD 057 Hamlin SD 125 Turner
SD 059 Hand SD 127 Union
SD 061 Hanson SD 129 Walworth
SD 063 Harding SD 133 Washington
SD 065 Hughes SD 135 Yankton
SD 067 Hutchinson SD 137 Ziebach
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For State Code = 47 - Tennessee 
State County County Name State County County Name
TN 001 Anderson TN 097 Lauderdale
TN 003 Bedford TN 099 Lawrence
TN 005 Benton TN 101 Lewis
TN 007 Bledsoe  TN 103 Lincoln
TN 009 Blount TN 105 Loudon
TN 011 Bradley  TN 107 McMinn
TN 013 Campbell TN 109 McNairy
TN 015 Cannon TN 111 Macon
TN 017 Carroll TN 113 Madison
TN 019 Carter TN 115 Marion
TN 021 Cheatham TN 117 Marshall
TN 023 Chester TN 119 Maury
TN 025 Claiborne TN 121 Meigs
TN 027 Clay TN 123 Monroe
TN 029 Cocke TN 125 Montgomery
TN 031 Coffee TN 127 Moore
TN 033 Crockett TN 129 Morgan
TN 035 Cumberland TN 131 Obion
TN 037 Davidson TN 133 Overton
TN 039 Decatur TN 135 Perry 
TN 041 De Kalb TN 137 Pickett
TN 043 Dickson TN 139 Polk
TN 045 Dyer TN 141 Putnam
TN 047 Fayette TN 143 Rhea
TN 049 Fentress TN 145 Roane
TN 051 Franklin TN 147 Robertson
TN 053 Gibson TN 149 Rutherford
TN 055 Giles TN 151 Scott 
TN 057 Grainger TN 153 Sequatchie
TN 059 Greene TN 155 Sevier
TN 061 Grundy TN 157 Shelby
TN 063 Hamblen TN 159 Smith
TN 065 Hamilton TN 161 Stewart
TN 067 Hancock TN 163 Sullivan
TN 069 Hardeman TN 165 Sumner
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TN 071 Hardin TN 167 Tipton
TN 073 Hawkins TN 169 Trousdale
TN 075 Haywood TN 171 Unicoi
TN 077 Henderson TN 173 Union
TN 079 Henry TN 175 Van Buren
TN 081 Hickman TN 177 Warren
TN 083 Houston TN 179 Washington
TN 085 Humphreys TN 181 Wayne
TN 087 Jackson TN 183 Weakley
TN 089 Jefferson TN 185 White
TN 091 Johnson TN 187 Williamson
TN 093 Knox TN 189 Wilson
TN 095 Lake
A.62 version 5.2 January 10, 2002



Appendix A. Codes FIRESTAT User’s Guide
For State Code = 48 - Texas 
State County County Name State County County Name
TX 001 Anderson TX 255 Karnes
TX 003 Andrews TX 257 Kaufman
TX 005 Angelina TX 259 Kendall
TX 007 Aransas TX 261 Kenedy
TX 009 Archer TX 263 Kent
TX 011 Armstrong TX 265 Kerr
TX 013 Atascosa TX 267 Kimble
TX 015 Austin TX 269 King 
TX 017 Bailey TX 271 Kinney
TX 019 Bandera TX 273 Kleberg
TX 021 Bastrop TX 275 Knox 
TX 023 Baylor TX 277 Lamar
TX 025 Bee TX 279 Lamb 
TX 027 Bell TX 281 Lampasas
TX 029 Bexar TX 283 LaSalle
TX 031 Blanco TX 285 Lavaca
TX 033 Borden TX 287 Lee
TX 035 Bosque TX 289 Leon
TX 037 Bowie TX 291 Liberty
TX 039 Brazoria TX 293 Limestone
TX 041 Brazos TX 295 Lipscomb
TX 043 Brewster TX 297 Live0ak
TX 045 Briscoe  TX 299 Llano 
TX 047 Brooks TX 301 Loving 
TX 049 Brown TX 303 Lubbock
TX 051 Burleson TX 305 Lynn
TX 053 Burnet TX 307 McCulloch
TX 055 Caldwell TX 309 McLennan
TX 057 Calhoun TX 311 McMullen
TX 059 Callahan TX 313 Madison
TX 061 Cameron  TX 315 Marion
TX 063 Camp TX 317 Martin
TX 065 Carson TX 319 Mason 
TX 067 Cass TX 321 Matagorda
TX 069 Castro TX 323 Maverick
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TX 071 Chambers TX 325 Medina
TX 073 Cherokee TX 327 Menard
TX 075 Childress TX 329 Midand
TX 077 Clay TX 331 Milam
TX 079 Cochran TX 333 Mills
TX 081 Coke TX 335 Mitchell
TX 083 Coleman TX 337 Montague
TX 085 Collin TX 339 Montgomery
TX 087 Collingsworth TX 341 Moore 
TX 089 Colorado TX 343 Morris
TX 091 Comal TX 345 Motley
TX 093 Comanche TX 347 Nacogdoches
TX 095 Concho TX 349 Navarro
TX 097 Cooke TX 351 Newton
TX 099 CoryeH TX 353 Nolan 
TX 101 Cottle TX 355 Nueces
TX 103 Crane TX 357 Ochiltree
TX 105 Crockett TX 359 Oldham
TX 107 Crosby TX 361 Orange 
TX 109 Culberson TX 363 Palo Pinto
TX 111 Dallam TX 365 Panola
TX 113 Dallas TX 367 Parker
TX 115 Dawson TX 369 Parmer
TX 117 Deaf Smith TX 371 Pecos
TX 119 Delta TX 373 Polk
TX 121 Denton TX 375 Potter 
TX 123 De Witt TX 377 Presidio
TX 125 Dickens TX 379 Rains
TX 127 Dimmit TX 381 Randall
TX 129 Donley TX 383 Reagan
TX 131 Duval TX 385 Real 
TX 133 Eastland TX 387 Red River
TX 135 Ector TX 389 Reeves
TX 137 Edwards TX 391 Refugio
TX 139 Ellis TX 393 Roberts
TX 141 El Paso TX 395 Robertson
TX 143 Erath TX 397 Rockwall
TX 145 Falls TX 399 Runnels
A.64 version 5.2 January 10, 2002



Appendix A. Codes FIRESTAT User’s Guide
TX 147 Fannin TX 401 Rusk 
TX 149 Fayette TX 403 Sabine
TX 151 Fisher TX 405 San Augustine
TX 153 Floyd TX 407 San Jacinto
TX 155 Foard TX 409 San Patricio
TX 157 Fort Bend TX 411 San Saba
TX 159 Franklin TX 413 Schleicher
TX 161 Freestone TX 415 Scurry
TX 163 Frio TX 417 Shackelford
TX 165 Gaines TX 419 Shelby
TX 167 Galveston TX 421 Sherman
TX 169 Garza TX 423 Smith 
TX 171 Gillespie TX 425 Somervell
TX 173 Glasscock  TX 427 Starr 
TX 175 Goliad TX 429 Stephens
TX 177 Gonzales TX 1431 Sterling 
TX 179 Gray TX 433 Stonewall
TX 181 Grayson TX 435 Sutton
TX 183 Gregg TX 437 Swisher
TX 185 Grimes TX 439 Tarrant
TX 187 Guadalupe TX 441 Taylor
TX 189 Hale TX 443 Terrell
TX 191 Hall TX 445 Terry 
TX 193 Hamilton TX 447 Throckmorton
TX 195 Hansford TX 449 Titus
TX 197 Hardeman TX 451 Tom Green
TX 199 Hardin TX 453 Trams
TX 201 Harris TX 455 Trinity
TX 203 Harrison TX 457 Tyler
TX 205 Hartley TX 459 Upshur
TX 207 Haskell TX 461 Upton
TX 209 Hays TX 463 Uvalde
TX 211 HemphW TX 465 Val Verde
TX 213 Henderson TX 467 Van Zandt
TX 215 Hidalgo TX 469 Victoria
TX 217 Hill TX 471 Walker
TX 219 Hockley TX 473 Waller
TX 221 Hood TX 475 Ward
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TX 223 Hopkins TX 477 Washington
TX 225 Houston TX 479 Webb
TX 227 Howard TX 481 Wharton
TX 229 Hudspeth TX 483 Wheeler
TX 231 Hunt TX 485 Wichita 
TX 233 Hutchinson TX 487 Wilbarger
TX 235 Irion TX 489 Willacy
TX 237 Jack TX 491 Williamson
TX 239 Jackson TX 493 Wilson
TX 241 Jasper TX 495 Winkler
TX 243 Jeff Davis TX 497 Wise
TX 245 Jefferson TX 499 Wood
TX 247 Jim Hogg TX 501 Yoakum
TX 249 Jim Wells TX 503 Young
TX 251 Johnson TX 505 Zapata
TX 253 Jones TX 507 Zavala
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For State Code = 49 - Utah 

For State Code = 50 - Vermont 

For State Code = 51 - Virginia

State County County Name State County County Name
UT 001 Beaver UT 031 Piute
UT 003 Box Elder UT 033 Rich
UT 005 Cache UT 035 Salt Lake
UT 007 Carbon UT 037 San Juan
UT 009 Daggett UT 039 Sanpete
UT 011 Davis UT 041 Sevier
UT 013 Duchesne UT 043 Summit
UT 015 Emery UT 045 Tooele
UT 017 Garfield UT 047 Uintah
UT 019 Grand UT 049 Utah
UT 021 Iron UT 051 Wasatch
UT 023 Juab UT 053 Washington
UT 025 Kane UT 055 Wayne
UT 027 Millard UT 057 Weber
UT 029 Morgan

State County County Name State County County Name
VT 001 Addison VT' 015 Lamoille
VT 003 Bennington VT 017 Orange
VT 005 Caledonia VT 019 Orleans
VT 007 Chittenden VT 021 Rutland
VT 009 Essex VT 023 Washington
VT 011 Franklin VT 025 Windham
VT 013 Grand Isle VT 027 Windsor

State County County Name State County County Name
VA 001 Accomack VA 143 Pittsylvania
VA 003 Albemarle VA 145 Powhatan 
VA 005 Alleghany VA 147 Prince Edward
VA 007 Amelia  VA 149 Prince George
VA 009 Amherst VA 153 Prince William
VA 011 Appomattox VA 155 Pulaski
VA 013 Arlington VA 157 Rappahannock
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VA 015 Augusta VA 159 Richmond
VA 017 Bath VA 161 Roanoke
VA 019 Bedford VA 163 Rockbridge
VA 021 Bland VA 165 Rockingham
VA 023 Botetourt VA 167 Russell
VA 023 Brunswick VA 169 Scott
VA 027 Buchanan VA 171 Shenandoah
VA 029 Buckingham VA 173 Smyth
VA 031 Campbell VA 175 Southampton
VA 033 Caroline VA 177 Spotsvlvania
VA 035 Carroll VA 179 Stafford
VA 036 Charles City VA 181 Surry 
VA 037 Charlotte VA 183 Sussex 
VA 041 Chesterfield VA 185 Tazewell
VA 043 Clarke VA 187 Warren 
VA 045 Craig VA 191 Washington 
VA 047 Culpeper VA 193 Westmoreland
VA 049 Cumberland VA 195 Wise 
VA 051 Dickenson VA 197 Wythe
VA 053 Dinwiddie VA 199 York 
VA 057 Essex VA 510 Alexandria
VA 059 Fairfax VA 515 Bedford
VA 061 Fauguier VA 520 Bristol 
VA 063 Floyd VA 530 Buena Vista 
VA 065 Fluvanna VA 540 Charlottesville
VA 067 Franklin VA 550 Chesapeake 
VA 069 Frederick VA 560 Clifton Forge 
VA 071 Giles VA 570 Colonial Heights
VA 073 Gloucester VA 580 Covington
VA 075 Goochland VA 590 Danville
VA 077 1 Grayson VA 595 Emporia
VA 079 Greene VA 600 Fairfax 
VA 081 Greensville VA 610 Falls Church
VA 083 Halifax VA 620 Franklin 
VA 085 Hanover VA 630 Fredericksburg
VA 087 Henrico VA 640 Galax 
VA 089 Henry VA 650 Hampton 
VA 091 Highland VA 660 Harrisonburg
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VA 093 Isle of Wight VA 670 Hopewell
VA 095 James City VA 678 Lexington 
VA 097 King and Queen VA 680 Lynchburg
VA 099 King George VA 683 Manassas 
VA 101 King William VA 685 Manassas Park
VA 103 Lancaster VA 690 Martinsville 
VA 105 Le VA 700 Newport News
VA 107 Loudoun VA 710 Norfolk
VA 109 Louisa VA 720 Norton 
VA 111 Lunenburg VA 730 Petersburg
VA 113 Madison VA 735 Poguoson 
VA 115 Mathews VA 740 Portsmouth
VA 117 Mecklenburg VA 750 Radford 
VA 119 Middlesex VA 760 Richmond
VA 121 Montgomery VA 770 Roanoke 
VA 123 Nansemond VA 775 Salem 
VA 125 Nelson VA 780 South Boston
VA 127 New Kent VA 790 Staunton
VA 131 Northampton VA 800 Suffolk 
VA 133 Northumberland VA 810 Virginia Beach
VA 135 Nottoway VA 820 Waynesboro
VA 137 Orange VA 830 Williamsburg
VA 139 Page VA 840 Winchester
VA 141 Patrick 
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For State Code = 53 - Washington 

For State Code = 54 - West Virginia 

State County County Name State County County Name 
WA 001 Adams WA 041 Lewis 
WA. 003 Asotin WA 043 Lincoln
WA 005 Benton WA 045 Mason 
WA 007 Chelan WA 047 Okanogan
WA 009 Clallam WA 049 Pacific 
WA 011 Clark WA 051 Pend Oreille
WA 013 Columbia WA 053 Pierce 
WA 015 Cowlitz WA 055 San Juan
WA 017 Douglas WA 057 Skagit 
WA 019 Ferry WA 059 Skamania 
WA 021 Franklin WA 061 Snohomish
WA 023 Garfield WA 063 Spokane
WA 025 Grant WA 065 Stevens 
WA 027 Grays Harbor WA 067 Thurston 
WA 029 Island -WA 069 Wahkiakum
WA 031 Jefferson WA 071 Walla Walla
WA 033 King WA 073 Whatcom
WA 035 Kitsap WA 075 Whitman
WA 037, Kittitas WA 077 Yakima
WA 039 Klickitat

State County County Name State County County Name 
WV 001 Barbour WV 057 Mineral
WV 003 Berkeley WV 059 Mingo 
WV 005 Boone WV 061 Monongalia
WV 007 Braxton WV 063 Monroe
WV 009 Brooke WV 065 Morgan 
WV 011 Cabell WV 067 Nicholas
WV 013 Calhoun WV 069 Ohio 
WV 015 Clay WV 071 Pendleton
WV 017 Doddridge WV 073 Pleasants 
WV 019 Fayette WV 075 Pocahontas 
WV 021 Gilmer WV 077 Preston
WV 023 Grant WV 079 Putnam
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WV 025 Greenbrier WV 081 Raleigh 
WV 027 Hampshire WV 083 Randolph
WV 029 Hancock WV 085 Ritchie
WV 031 Hardy WV 087 Roane 
WV 033 Harrison WV 089 Summers
WV 035 Jackson WV 091 Taylor
WV 037 Jefferson WV 093 Tucker
WV 039 Kanawha WV 095 Tyler 
WV 041 Lewis WV 097 Upshur
WV 043 Lincoln WV 099 Wayne 
WV 045 Logan WV 101 Webster
WV 047 McDowell WV 103 Wetzel
WV 049 Marion WV 105 Wirt 
WV 051 Marshall WV 107 Wood 
WV 053 Mason WV 109 Wyoming
WV 055 Mercer
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For State Code = 55 - Wisconsin
State County County Name State County County Name 
WI 001 Adaras WI 073 Marathon
WI 003 Ashland WI 075 Marinette
WI 005 Barron WI 077 Marquette 
WI 007 Bayfield WI 078 Menominee
WI 009 Brown WI 079 Milwaukee
WI 011 Buffalo WI 081 Monroe
WI 013 Burnett WI 083 Oconto
WI 015 Calumet WI 085 Oneida 
WI 017 Chippewa WI 087 Outagamie
WI 019 Clark WI 089 Ozaukee
WI 021 Columbia WI 091 Pepin
WI 023 Crawford WI 093 Pierce
WI 025 Dane WI 095 Polk 
WI 027 Dodge WI 097 Portage
WI 029 Door WI 099 Price 
WI 031 Douglas WI 101 Racine
WI 033 Dunn WI 103 Richland
WI 035 Eau Claire WI 105 Ro,-Il
WI 037 Florence WI 107 Rusk 
WI 039 Fond Du Lac WI 109 Saint Croix
WI 041 Forest WI 111 Sauk 
WI 043 Grant WI 113 Sawyer 
WI 045 Green WI 115 Shawano 
WI 047 Green Lake WI 117 Sheboygan
WI 049 Iowa WI 119 Taylor 
WI 051 Iron WI 121 Trempealeau
WI 053 Jackson WI 123 Vernon
WI 055 Jefferson WI 125 Vilas 
WI 057 Juneau WI 127 Walworth
WI 059 Kenosha WI 129 Washburn 
WI 061 Kewaunee WI 131 Washington
WI 063 La Crosse WI 133 Waukesha
WI 065 Lafayette WI 135 Waupaca
WI 067 Langlade WI 137 Waushara
WI 069 Lincoln WI 139 Winnebago 
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For State Code = 56 - Wyoming 

WI 071 Manitowoc WI 141 Wood 

State County County Name State County County Name 
WY 001 Albany WY 025. Natrona
WY 003 Big Horn WY 027 Niobrara
WY 005 Campbell WY 029 Park 
WY 007 Carbon WY 031 Platte 
WY 009 Converse WY 033 Sheridan
WY 011 Crook WY 035 Sublette 
WY 013 Fremont WY 037 Sweetwater
WY 015 Goshen WY 039 Teton
WY 017 Hot Springs WY 041 Uinta 
WY 019 Johnson WY 043 Washakie
WY 021 Laramie WY 045 Weston 
WY 023 Lincoln
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Wilderness areas by Region
Region 1 
Adm 
Unit Forest State Wilderness ID 

0102 Beaverhead NF MT Anaconda-Pintlar 47
0102 Beaverhead NF MT Lee Metcalf 188
0103 Bitterroot NF MT Anaconda-Pintlar 47
0103 Bitterroot NF ID Frank Church-River of No Return 136
0103 Bitterroot NF ID Selway-Bitterroot 44
0103 Bitterroot NF MT_ Selway-Bitterroot 44
0104 Kaniksu NF MT Cabinet Mountains 50
0104 Kaniksu NF WA Salmo-Priest 239
0105 Clearwater NF ID Selway-Bitterroot 44
0108 Custer NF MT Absaroka-Beartooth 131
0109 Deerlodge NF MT Anaconda-Pintlar 47
0110 Flathead NF MT Bob Mars .hall 49
0110 Flathead NF MT Great Bear 135
0110 Flathead NF MT Mission Mountains 52
0111 Gallatin NF MT Absaroka-Beartooth 131
0111 Gallatin NF MT Lee Metcalf 188
0112 Helena NF MT Gates of the Mountains 51
0112 Helena NF MT Scapegoat 90
0114 Kootenai NF MT Cabinet Mountains 50- 
0115 Lewis & Clark NF MT Bob Marshall 49
0115 Lewis & Clark NF MT Scapegoat 90
0116. Lolo NF MT Rattlesnake 137
0116 Lolo NF MT Scapegoat 90
0116 Lolo NF MT Selway-Bitterroot 44
0116 Lolo NF MT Welcome Creek 123 
0117 Nez Perce NF ID Frank Church-River of No Return 136
0117 Nez Perce NF ID Gospel Hump 122
0117 Nez Perce NF ID Hells Canyon 92
0117 Nez Perce NF ID Selway-Bitterroot 44 
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Region 2 
Adm 
Unit Forest State Wilderness ID 

0202 Bighorn NF WY Cloud Peak 80
0203 Black Hills NF SD Black Elk 172
0204 Gunnison NF CO Collegiate Peaks 161
0204 Gunnison NF CO Fossil Ridge 416
0204 Gunnison NF CO La Garita 32
0204 Uncompahgre NF CO Lizard Head 40
0204 Gunnison NF CO Maroon Bells-Snowmass 33
0204 Uncompahgre NF CO Mount Sneffels 167
0204 Gunnison NF CO Powderhorn 413
0204 Gunnison NF CO Raggeds 170
0204 Uncompahgre NF CO Uncompahgre 37
0204 Uncompahgre NF CO Uncompahgre 37
0204 Gunnison NF CO West Elk 39
0206 Medicine Bow NF WY Encampment River 327
0206 Routt NF CO Flat Tops 30
0206 Medicine Bow NF WY Huston Park 326
0206 Routt NF CO Mount Zirkel 34
0206 Routt NF CO Mount Zirkel 34
0206 Routt NF CO Neota 168
0206 Routt NF CO Never Summer 169
0206 Routt NF CO Platte River 348
0206 Medicine Bow NF WY Platte River 348
0206 Routt NF CO Rawah 35
0206 Routt NF CO Sarvis Creek 417
0206 Medicine Bow NF WY Savage Run 130
0207 Nebraska NF NE Soldier Creek 359
0209 Rio Grande NF CO La Garita 32
0209 Rio Grande NF CO La Garita 32
0209 San Juan NF @ CO Lizard Head 40
0209 Rio Grande NF CO Sangre de Cristo 414
0209 San Juan NF CO South San Juan 171
0209 Rio Grande NF CO South San Juan 171
0209 San Juan NF CO South San Juan 171
0209 San Juan NF CO Wen-dnuche 36
0209 Rio Grande NF CO Wen-dnuche 36
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0210 Arapaho NF CO Byers Peak 412
0210 Roosevelt NF CO Cache La Poudre 160
0210 Roosevelt NF CO Comanche Peak 162
0210 Arapaho NF CO Eagles Nest 31 
0210 Roosevelt NF CO Indian Peaks 134
0210 Arapaho NF CO Mount Evans 165
0210 Roosevelt NF CO Neota 168
0210 Arapaho NF CO Never Summer 169
0210 Arapaho N-F CO Never Summer 169 
0210 Arapaho NF CO Ptarmigan Peak 418
0210 Roosevelt NF CO Rawah 33
0210 Arapaho NF CO Vasquez Peak 415
0212 San Isabel NF CO Buffalo Peaks 410
0212 Pike NF CO Buffalo Peaks 410
0212 San Isabel NF CO Collegiate Peaks 161
0212 San Isabel NF CO Greenhorn Mountain 411
0212 San Isabel NF CO Holy Cross 163
0212 Pike NF CO Lost Creek 164
0212 Pike NF CO Lost Creek 164
0212 Pike NF CO Mount Evans 165
0212 San Isabel NF CO Mount Massive 166
]0212 San Isabel NF CO Sangre de Cristo 414
0214 Shoshone NF WY Absaroka-Beartooth 131
0214 Shoshone NF WY Fitzpatrick 117
0214 Shoshone NF WY North Absaroka 82
0214 Shoshone NF WY Popo Agie 83
0214 Shoshone NF WY Washakie 85
0215 White River NF CO Collegiate Peaks 161
0215 White River NF CO Eagles Nest 31
0215 White River NF CO Flat Tops 30
0215 White River NF CO Holy Cross 163
0215 White River NF CO Hunter-Fryingpan 121
0215 White River NF CO Hunter-Fryingpan 121
0215 White River NF CO Maroon Bells-Snowmass 33
0215 White River NF CO Raggeds 170
0415 Targhee NF WY Jedediah Smith 325
0415 Targhee NF WY Winegar Hole 324
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0301 Apache NF AZ Bear Wallow 256
0301 Apache NF NM Blue Range 154
0301 Apache MF AZ Escudilla 251
0301 Apache NF AZ Mount Baldy 5
0302 Carson NF NM Chama River Canyon 124
0302 Carson NF NM Cruces Basin 156
0302 Carson NF NM Latir Peak 158
0302 Carson NF NM Pecos 59
0302 Carson NF NM Wheeler Peak 61
0303 Cibola NF NM Apache Kid 133
0303 Cibola NF NM Manzano Mountain 125
0303 Cibola NF NM Sandia Mountain 126
0303 Cibola NF NM Withington 159
0304 Coconino NF AZ Fossil Springs 258
0304 Coconino NF AZ Kachina Peaks 245
0304 Coconino NF AZ Kendrick Mountain 263
0304 Coconino NF AZ Mazatzal 4
0304 Coconino.NF AZ Munds Mountain 266
0304 Coconino NF AZ Red Rock-Secret Mountain 268
0304 Coconino NF AZ Strawberry Crater 250
0304 Coconino NF AZ Sycamore Canyon 9
0304 Coconino NF AZ West Clear Creek 247
0304 Coconino NF AZ Wet Beaver 248
0305 Coronado NF AZ Chiricahua 2
0305 Coronado NF AZ Galiuro 3
0305 Coronado NF AZ Miller Peak 264
0305 Coronado NF AZ Mount Wrightson 265
0305 Coronado NF AZ Pajarita 267
0305 Coronado NF AZ Pusch Ridge 118
0305 Coronado NF AZ Rincon Mountain 269
0305 Coronado NF AZ Santa Teresa 246
0306 Gila NF NM Aldo Leopold 152
0306 Gila NF NM Blue Range 154
0306 Gila NF NM Gila 58
0307 Kaibab NF AZ Kanab Creek 252
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0307 Kaibab NF AZ Kendrick Mountain 263
0307 Kaibab NF AZ Saddle Mountain 253
0307 Kaibab NF AZ Sycamore Canyon 9
0308 Lincoln NF NM Capitan Mountain 155
0308 Lincoln NF NM White Mountain 62
0309 Prescott NF AZ Apache Creek 254
0309 Prescott NF AZ Castle Creek 7 
0309 Prescott NF AZ Cedar Bench 255
0309 Prescott NF AZ Granite Mountain 260
0309 Prescott NF AZ Juniper Mesa 262
0309 Prescott NF AZ Pine Mountain 6
0309 Prescott NF AZ Sycamore Canyon 9
0309 Prescott NF AZ Woodchute 249
0310 Santa Fe NF NM Chama River Canyon 124
0310 Santa Fe NF NM Dome 157
0310 Santa Fe NF NM Pecos 59
0310 Santa Fe NF NM San Pedro Parks 60
0312 Tonto NF AZ Four Peaks 259
0312 Tonto AZ Hellsgate 261
0312 Tonto NF AZ Mazatzal 4
0312 Tonto NF AZ Pine Mountain 6
0312 Tonto NF AZ Salome 270
0312 Tonto NF AZ Salt River Canyon 271
0312 Tonto NF AZ Sierra Ancha 7
0312 Tonto NF AZ Superstition 8
A.78 version 5.2 January 10, 2002



Appendix A. Codes FIRESTAT User’s Guide
Region 4 
Adm 
Unit Forest State Wilderness ID

0401 Ashley NF UT High Uintas 299
0402 Boise NF ID Frank Church-River of No Return 136
0402 Boise NF ID Sawtooth 43
0403 Bridger NF WY Bridger 79
0403 Teton NF WY Gros Ventre 323
0403 Teton NF WY Teton 86
0406 Chalhs NF ID Frank Church-River of No Return 136
0406 Challis NF ID Sawtooth 43
0407 Dixie NF UT Ashdown Gorge 303
0407 Dixie NF UT Box-Death Hollow 304
0407 Dixie UT Pine VaHey Mountain 305
0409 Humboldt NF NV Currant Mountain 381
0409 Humboldt NF NV East Humboldts 382
0409 Humboldt NF NV Grant Range 385
0409 Humboldt NF NV Jarbidge 54
0409 Humboldt NF NV Mount Moriah 386
0409 Humboldt NF NV Quinn Canyon 383
0409 Humboldt NF NV Ruby Mountains 384
0409 Humboldt NF NV Santa Rosa - Paradise Peak 387
0410 Manti-La Sal NF UT Dark Canyon 302
0412 Payette NF ID Frank Church-River of No Return 136
0412 Payette NF ID Hells Canyon 92
0413 Salmon NF ID Frank Church-River of No Return 136
0414 Sawtooth NF ID Sawtooth 43
0417 Toiyabe NF NV Alta Toquima 377
0417 Toiyabe NF NV Arc Dome 378
0417 Toiyabe NF CA Carson-Iceberg 272
0417 Toiyabe NF CA Hoover  18
0417 Toiyabe NF CA Mokelumne 20
0417 Toiyabe NF NV Mount Charleston 380
0417 Toiyabe NF NV Mount Rose 379
0417 Toiyabe NF NV Table Mountain 376
0418 Uinta NF UT Lone Peak 128
0418 Uinta NF UT Mount Nebo 301
0418 Uinta UT Mount Timpanogos 300
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0419 Wasatch NF UT Deseret Peak 306
0419 Wasatch NF UT High Uintas 299
0419 Wasatch NF UT Lone Peak 128
0419 Cache NF UT Mount Naomi 295
0419 Wasatch NF UT Mount Olympus 297
0419 Wasatch NF UT Twin Peaks 298
0419 Cache NF UT Wellsville Mountain 296 
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0501 Angeles NF CA Cucamonga 12
0501 Angeles NF CA San Gabriel 14
0501 Angeles NF CA Sheep Mountain 287
0502 Cleveland NF CA Agua Tibia 10
0502 Cleveland NF CA Hauser 278
0502 Cleveland NF CA Pine Creek 283 
0502 Cleveland NF CA San Mateo Canyon 285
0503 Eldorado NF CA Desolation 13
0503 Eldorado NF CA Mokelumne 20
0504 Inyo NF CA Ansel Adams 21
0504 Inyo NF NV Boundary Peak 404
0504 Inyo NF CA Golden Trout 119
0504 Inyo NF CA Hoover 18
0504 Inyo NF CA John Muir 87
0504 Inyo NF CA South Sierra 290
0505 Klamath NF CA Marble Mountain 19
0505 Klamath NF CA Russian 284
0505 Klamath NF CA Siskiyou 288
0505 Klamath NF CA Trinity Alps 291
0506 Lassen NF CA Caribou  11
0506 Lassen NF CA Ishi 279
0506 Lassen NF CA Thousand Lakes 27
0507 Los Padres NF CA Chumash 408
0507 Los Padres NF CA Dick Smith 275
0507 Los Padres NF CA Garcia 407
0507 Los Padres NF CA Machesna Mountain 293
0507 Los Padres NF CA Matilija 406
0507 Los Padres NF CA San Rafael 25
0507 Los Padres NF CA Santa Lucia 120
0507 Los Padres NF CA Sespe 405
0507 Los Padres NF- CA Silver Peak 409
0507 Los Padres NF CA Ventana 28
0507 Los Padres NF CA Ventana 28
0508 Mendocino NF CA Snow Mountain 289
0508 Mendocino NF CA Yolla Bolly-Middle Eel 29
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0509 Modoc NF CA South Warner 26
0510 Six Rivers NF CA North Fork 282
0510 Six Rivers NF CA Siskiyou 288
0510 Six Rivers NF CA Trinity Alps 291
0510 Six Rivers NF CA Yolla Bolly-Middle Eel 29
0511 Plumas NF CA Bucks Lake 292
0512 San Bernardino NF CA Cucamonga 12
0512 San Bernardino NF CA San Gorgonio 23
0512 San Bernardino NF CA San Jacinto 24
0512 San Bernardino NF CA Santa Rosa 286
0512 San Bernardino NF. CA Sheep Mountain 287
0513 Sequoia NF CA Dome Land 15
0513 Sequoia NF CA Golden Trout 119
0513 Sequoia NF CA Jennie Lakes 294
0513 Sequoia NF CA Monarch 280
0513 Sequoia NF CA South Sierra 290
0514 Shasta NF CA Castle Crags 273
0514 Trinity NF CA Chanchelulla 274
0514 Shasta NF CA Mount Shasta 281
0514 Shasta NF CA Trinity Alps 291
0514 Trinity NF CA Trinity Alps 291
0514 Trinity NF CA Yolla Bolly-Middle Eel 29
0515 Sierra NF CA Ansel Adams 21
0515 Sierra NF CA Dinkey Lakes 276
0515 Sierra NF CA John Muir 87
0515 Sierra NF CA Kaiser 94
0515 Sierra NF CA Monarch 280 
0516 Stanislaus NF CA Mokelumne 20
0517 Tahoe NF CA Granite Chief 277
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0601 Deschutes NF OR Diamond Peak 64
0601 Deschutes NF OR Mount Jefferson 69
0601 Deschutes NF OR Mount Thielsen 226
0601 Deschutes NF OR Mount Washington 70
0601 Deschutes NF OR Three Sisters 73
0602 Fremont NF OR Gearhart Mountain 66
0603 Gifford Pinchot NF WA Glacier View 231
0603 Gifford Finchot NF WA Goat Rocks 76
0603 Gifford Pinchot NF WA Indian Heaven 233
0603 Gifford Pinchot NF WA Mount Adams 77
0603 Gifford Pinchot NF WA Tatoosh  240
0603 Gifford Pinchot NF WA Trapper Creek 242
0603 Gifford Pinchot NF WA William 0. Douglas 243
0604 Malheur NF OR Monument Rock 225
0604 Malheur NF OR Strawberry Mountain 72
0605 Snogualmie NF WA Alpine Lakes 93
0605 Mt. Baker NF WA Boulder River 227
0605 Snoqualmie NF WA Clearwater 229
0605 Mt. Baker NF WA Glacier Peak 75
0605 Snoqualmie NF WA Goat Rocks 76
0605 Snoqualmie NF WA Henry M. Jackson 232
0605 Mt. Baker NF WA Henry M. Jackson 232
0605 Mt. Baker NF WA Mount Baker 235
0605 Mt. Baker NF WA Noisy-Diobsud 237
0605 Snoqualmie NF WA Norse Peak 238
0605 Mt. Baker NF WA Pasayten 89
0605 Snoqualmie NF WA William 0. Douglas 243
0606 Mt. Hood NF OR Badger Creole 207
0606 Mt. Hood NF OR Bull of the Woods 208
0606 Mt. Hood NF OR Columbia 205
0606 Mt. Hood NF OR Mount Hood 68
0606 Mt. Hood NF OR Mount Jefferson 69
0606 Mt. Hood NF OR Salmon-Huckleberry 206
0607 Ochoco NF OR Black Canyon 222
0607 Ochoco NF OR Bridge Creek 220
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0607 Ochoco NF OR Mill Creek 221
0605 Mt. Baker NF WA Henry M. Jackson 232
0605 Mt. Baker NF WA Mount Baker 235
0605 Mt. Baker NF WA Noisy-Diobsud 237
0605 Snoqualmie NF WA Norse Peak 238
0605 Mt. Baker NF WA Pasayten 89
0605 Snoqualmie NF WA William 0. Douglas 243
0606 Mt. Hood NF OR Badger Creek 207
0606 Mt. Hood NF OR Bull of the Woods 208
0606 Mt. Hood NF OR Columbia 205
0606 Mt. Hood NF OR Mount Hood 68
0605 Mt. Baker NF WA Henry M. Jackson 232
0605 Mt. Baker NF WA Mount Baker 235
0605 Mt. Baker NF WA Noisy-Diobsud 237
0605 Snoqualmie NF WA Norse Peak 238
0605 Mt. Baker NF WA Pasayten 89
0605 Snoqualmie NF WA William 0. Douglas 243
0606 Mt. Hood NF OR Badger Creek 207
0606 Mt. Hood NF OR Bull of the Woods 208
0606 Mt. Hood NF OR Columbia 205
0606 Mt. Hood NF OR Mount Hood 68
0606 Mt. Hood NF OR Mount Jefferson 69

0606 Mt. Hood NF OR Salmon-Huckleberry 206

0607 Ochoco NF OR Black Canyon 222

0607 Ochoco NF OR Bridge Creek 220

0607 Ochoco NF OR Mill Creek 221

0608 Okanogan NF WA Lake Chelan-Sawtooth 234

0608 Okanogan NF WA Pasayten 89

0609 Olympic NF WA Buckhom 228

0609 Olympic NF WA Colonel Bob 230

0609 Olympic NF WA Mount Skokomish 236

0609 Olympic NF WA The Brothers 241

0609 Olympic NF WA Wonder Mountain 244

0610 Rogue River NF CA Red Buttes 218

0610 Rogue River NF OR Red Buttes 218

0610 Rogue River NF OR Rogue-Umpqua Divide 213

0610 Rogue River NF OR Sky Lakes 219
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0611 Stanislaus NF CA Carson-Iceberg 272

0611 Stanislaus NF CA Emigrant 16

0611 Siskiyou NF OR Grassy Knob 217

0611 Siskiyou NF OR Kalmiopsis 67

0611 Siskiyou NF OR Red Buttes 218

0611 Siskiyou NF CA Siskiyou 288

0611 Siskiyou NF OR Wild Rogue 127

0612 Siuslaw NF OR Cummins Creek 211

0612 Siuslaw NF OR Drift Creek 209

0612 Siuslaw NF OR Rock Creek 210

0614 Umatilla NF OR North Fork John Day 223

0614 Umatilla NF OR North Fork Umatilla 224 

0614 Umatilla NF WA Wenaha-Tucannon 129

0614 Umatilla NF OR Wenaha-Tucannon 129

0615 Umpqua NF OR Boulder Creek 212

0615 Umpqua NF OR Mount Thielsen 226

0615 Umpqua NF OR Rogue-Umpqua Divide 213

0616 Wallowa NF OR Eagle Cap 63

0616 Whitman NF OR Eagle Cap 65

0616 Wallowa NF OR Hells Canyon 92

0616 Whitman NF OR Hells Canyon 92

0616 Whitman NF OR Monument Rock 223

0616 Whitman NF OR North Fork John Day 223

0617 Wenatchee NF WA Alpine Lakes 93

0617 Wenatchee NF WA Glacier Peak 75

0617 Wenatchee NF WA Henry M. Jackson 232

0617 Wenatchee NF WA Lake Chelan-Sawtooth 234

0618 Willamette NF OR Bull of the Woods 208

0618 Willamette NF OR Diamond Peak 64

0618 Willamette NF OR Menagerie 215

0618 Willamette NF OR Middle Santiam 216 

0618 Willamette NF OR Mount Jefferson 69

0618 Willaniette NF OR Mount Washington 70

0618 Willamette NF OR Three Sisters 73

0618 Willamette NF OR Waldo Lake 214
January 10, 2002 version 5.2 A.85



FIRESTAT User’s Guide Appendix A. Codes
0620 Winema NF OR Mount Thielsen 226

0620 Winema NF OR Mountain Lakes 71

0620 Winema NF OR Sky Lakes 219

0621 Colville NF WA Salmo-Priest 239
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0801 Talladega NF AL Cheaha 184
0801 William B. Bankhead NF AL Sipsey 100
0802 Daniel Boone NF KY Beaver Creek 104
0802 Daniel Boone NF KY Clifty 349
0803 Chattahoochee NF GA Big Frog 330
0803 Chattahoochee NF GA Blood Mountain 402
0803 Chattahoochee NF GA Brasstown 351
0803 Chattahoochee NF GA Cohutta 110
0803 Chattahoochee NF GA Ellicott Rock 107
0803 Chattahoochee NF GA Mark Trail 403
0803 Chattahoochee NF GA Raven Cliffs 350
0803 Chattahoochee NF GA Rich Mountain 353
0803 Chattahoochee NF GA Southern Nantahala 204
0803 Chattahoochee NF GA Tray Mountain 352
0804 Cherokee NF TN Bald River Gorge 332
0804 Cherokee NF TN Big Frog 330
0804 Cherokee NF TN Big Laurel Branch 357
0804 Cherokee NF TN Citico Creek 331
0804 Cherokee NF TN Cohutta 110
0804 Cherokee NF TN Gee Creek 108
0804 Cherokee NF TN Joyce Kilmer-Slickrock 106
0804 Cherokee NF TN Little Frog Mountain 354
0804 Cherokee NF TN Pond Mountain 355
0804 Cherokee NF TN Sampson Mountain 358
0804 Cherokee NF TN Unaka Mountain 356
0803 Ocala NF FL Alexander Springs 309
0805 Osceola NF FL Big Gum Swamp 308
0805 Ocala NF FL Billies Bay 312
0805 Apalachicola NF FL Bradwell Bay 103
0805 Ocala NF FL Juniper Prairie 310
0805 Ocala NF FL Little Lake George 311
0805 Apalachicola NF FL Mud Swamp-New River 307
0806 Kisatchie NF LA Kisatchie Hills 180
0807 Desoto NF MS Black Creek 321
0807 Desoto NF MS Leaf 322
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0809 Ouachita NF OK Black Fork Mountain 313
0809 Ouachita NF AR Black Fork Mountain 313
0809 Ouachita NF AR Caney Creek 101
0809 Ouachita NF AR Dry Creek 314
0809 Ouachita NF AR Flatside  316
0809 Ouachita NF AR Poteau Mountain 315
0809 Ouachita NF OK Upper Kiamichi River 374
0810 Ozark NF AR East Fork 319
0810 Ozark NF AR Hurricane Creek 317
0810 Ozark NF AR Leatherwood 320
0810 Ozark NF AR Richland Creek 318
0810 Ozark NF AR Upper Buffalo 102
0811 Uwharrie NF NC Birkhead Mountains 198
081l Croatan NF NC Catfish Lake South 199
0811 Nantahala NF NC Ellicott Rock 107
0811 Nantahala NIF NC Joyce Kilmer-Slickrock 106
0811 Pisgah NF NC Linville Gorge 63 
0811 Pisgah NF NC Middle Prong 200
0811 Croatan NF NC Pocosin 201
0811 Croatan NF NC Pond Pine 202
0811 Croatan NF NC Sheep Ridge 203
0811 Pisgah NF NC Shining Rock 88
0811 Nantahala NF NC Southern Nantahala 204
0812 Sumter NF SC Ellicott Rock 107
0812 Francis Marion NF SC Hell Hole Bay 178
0812 Francis Marion NF SC Little Wambaw Swamp 181
0812 Francis Marion NF SC Wambaw Creek 179
0812 Francis Marion NF SC Wambaw Swamp 177
0813 Davy Crockett NF TX Big Slough 335
0813 Sabine NF TX Indian Mounds 336
0813 Sam Houston NF TX Little Lake Creek 337
0813 Angelina NF TX Turkey Hill 333
0813 Angelina NF TX Upland Island 334
0814 Jefferson NF VA Barbours Creek 362
0814 George Washington NF VA Barbours Creek 362
0814 Jefferson NF VA Beartown 338
0814 Jefferson NF VA James River Face 109
0814 Jefferson NF VA Kimberling Creek 339
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0814 Jefferson NF VA Lewis Fork 340
0814 Jefferson NF VA Little Dry Run 341
0814 Jefferson NF VA Little Wilson Creek 342
0814 Jefferson NF WV Mountain Lake 34
 0814 Jefferson NF VA Mountain Lake 343
0814 Jefferson NF VA Peters Mountain 344
0814 George Washington NF VA Ramseys Draft 346
0814 George Washington NF VA Rich Hole 361
0814 George Washington NF VA Rough Mountain 360
0814 George Washington NF VA Saint Mary's 347
0814 George Washington NF VA Shawvers Run 363
0814 Jefferson NF VA Shawvers Run 363
0814 Jefferson NF VA Thunder Ridge 345
January 10, 2002 version 5.2 A.89



FIRESTAT User’s Guide Appendix A. Codes
Region 9 
Adm 
Unit Forest State Wilderness ID

0902 Chequamegon NF WI Porcupine Lake 190
0902 Chequamegon NF WI Rainbow Lake 115
0904 Manistee NF MI Nordhouse Dunes 364
0905 Mark Twain NF MO Bell Mountain 173
0905 Mark Twain NF MO Devils Backbone 176
0905 Mark Twain NIF MO Hercules-Glades 116
0905 Mark Twain NIF MO Irish 189
0905 Mark Twain NF MO Paddy Creek 183
0905 Mark Twain NIF MO Piney Creek 175
0905 Mark Twain NIF MO Rockpile Mountain 174
0906 Nicolet NF WI Blackjack Springs 132
0906 Nicolet NF WI Headwaters 191
0906 Nicolet NF WI Whisker Lake 133
0907 Ottawa NF MI McCormick 372
0907 Ottawa NF MI Sturgeon River Gorge 366
0907 Ottawa NF MI Sylvania 365
0908 Shawnee NF IL Bald Knob 395
0908 Shawnee NF IL Bay Creek 396
0908 Shawnee NF IL Burden Falls 397
0908 Shawnee NF IL Clear Springs 398
0908 Shawnee NF IL Garden of the Gods 399
0908 Shawnee NF IL Lusk Creek 400
0908 Shawnee NF IL Panther Den 401
0909 Superior NF MN Boundary Waters Canoe Area 45
0910 Hiawatha NF MI Big Island Lake 368
0910 Hiawatha NF MI Delirium 373
0910 Hiawatha NF MI Horseshoe Bay 370
0910 Hiawatha NF MI Mackinac 369
0910 Hiawatha NF MI Rock River Canyon 367
0910 Hiawatha NF MI Round Island 371
0912 Hoosier NF PA Charles C. Deam 182
0919 Allegheny NF PA Allegheny Islands 328
0919 Allegheny NF PA Hickory Creek 329
0920 Green Mountain NF VT Big Branch 193
0920 Green Mountain NF VT Breadloaf 192
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0920 Green Mountain NF VT Bristol Cliffs 111
0920 Green Mountain NF VT George D. Aiken 195
0920 Green Mountain NF VT Lye Brook 112
0920 Green Mountain NF VT Peru Peak 194
0921 Monongahela NF WV Cranberry 185
0921 Monongahela NF WV Dolly Sods 113
0921 Monongahela NF WV Laurel Fork North 186 
0921 Monongahela NF WV Laurel Fork South 187
0921 Monongahela NF WV Otter Creek 114
092-2 White Mountain NF NE Caribou-Speckled Mountain 388
0922 White Mountain NF NH Great Gulf 55
0922 White Mountain NF NH Pemiwegasset 196
0922 White Mountain NF NH Presidential Range-Dry River 105
0922 White Mountain NF NH Sandwich Range 197

Adm 
Unit Forest State Wilderness ID 

1000 Tongass NF AK Chuck River 390
1000 Tongass NF AK Coronation Island 140
1000 Tongass NF AK Endicott River 139
1000 Tongass NF AK Karta River 391
1000 Tongass NF AK Kootznoowoo 138
1000 Tongass NF AK Kuiu 392
1000 Tongass NF AK Maurelle Islands 142
1000 Tongass NF AK Misty Fiords 143
1000 Tongass NF AK Petersburg Creek-Duncan Salt Chuck 144
1000 Tongass NF AK Pleasant-Lemusurier-Inian 393
1000 Tongass NF AK Russell Fiord 146
1000 Tongass NF AK South Baranof 148
1000 Tongass NF AK South Etolin 389
1000 Tongass NF AK South Prince of Wales 145
1000 Tongass NF AK Stikine-LeConte 147
1000 Tongass NF AK Tebenkof Bay 149
1000 Tongass NF AK Tracy Arm-Fords Terror 150
1000 Tongass NF AK Warren Island 141
1000 Tongass NF AK West Chichagof-Yakobi 151
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Glossary

A
ambient.  Surrounding, enveloping conditions.  As it pertains 
to weather at the earth’s surface, the conditions measured in 
the instrument shelter are considered ambient.

annual.  A plant that lives for one growing season, starting 
from a seed each year.

appropriate suppression response.  The planned 
strategy for suppression action (in terms of kind, amount, and 
timing) on a wildfire that most efficiently meets fire 
management direction under current and expected burning 
conditions.  The response may range from a strategy of prompt 
control to one of containment or confinement.

Aspect.  Represents the aspect at the weather station site. 
Used in NFDRS calculations.  Valid values are 1 - 8:

1 - N 5 - S
2 - NE 6 - SW
3 - E 7 - W
4 - SE 8 - NW

Average Precip.  The historic average annual precipitation 
for the weather station.  Used in NFDRS calculations.

average relative humidity.  The arithmetic average of the 
maximum and minimum relative humidities measured at a 
fire-danger station from one basic observation time to the next.

B
base fuel model.  The fuel model that best represents the 
fuels on the base area.

basic observation time.  The time established to take the 
fire-dander observation.  It should be at that time of day when 
the fire danger is normally the highest.

batch job.  A request or job submitted from the personal 
computer to the National Interagency Technology Center 
(NITC) that includes all information necessary to process 
without further user direction.  The job is sent to NITC, 
processed, and returned to the submitting site.

boundary conditions.  The temperature and relative 
humidity of the boundary layer.

boundary layer.  The EMC commensurate with the 
boundary conditions and precipitation events of the preceding 
24 hours.

brush.  Scrub vegetation and stands of tree species that do not 
produce merchantable timber.  Not a synonym for slash.

Burning Index (BI).  A number related to the contribution of 
fire behavior to the effort of containing a fire.

C
climate class.  Defines the drying and wetting rates for 
annuals, perennials, and woody plants.

completed fire report.  A record, which contains the 
information from an FS-5100-29, that has passed FIRESTAT’s 
error checking process.

confine.  To limit fire spread within a predetermined area 
principally by use of natural or preconstructed barriers or 
environmental conditions.  Suppression action may be 
minimal and limited to surveillance under appropriate 
conditions.

contain, containment.  The completion of a control line 
around a fire and any associated spot fires that can reasonably 
be expected to check the fire’s spread.

control.  The completion of a control line around a fire and 
any associated spot fires that can reasonably be expected to 
hold under foreseeable conditions.  Control implies that the 
line has been burned out and all hot spots that threaten the line 
have been eliminated.

D
dead fuels.  Naturally occurring fuels whose moisture 
content is governed by relative humidity and precipitation.

Deciduous.  When checked, this flag signifies that trees at 
the weather station site are primarily deciduous.  When 
unchecked, this flag signifies primarily coniferous trees at the 
weather station site.  Used in NFDRS calculations.

dew point.  The temperature at which a parcel of air being 
cooled reaches saturation (100 percent relative humidity).

diurnal.  Pertains to daily cycles of temperature, relative 
humidity, and wind.

drought.  A period characterized by a serious moisture 
deficiency, extensive in area and time.

dry bulb temperature.  The temperature of the air.

duff.  The partially decomposed organic material of the forest 
floor that lies beneath the freshly fallen twigs, needles, and 
leaves.
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E
Elevation.  The elevation, in feet, of the weather station.  
Used in NFDRS calculations. 

Energy Release Component (ERC).  A number related to 
the available energy (Btu) per unit area (square foot) within 
the flaming front at the head of a fire.

Equilibrium Moisture Content (EMC).  The moisture 
content that a fuel particle will attain if exposed for an infinite 
period in an environment of specified constant temperature 
and humidity.  When a fuel particle has reached its EMC, the 
net exchange of moisture between it and its environment is 
zero.

escaped fire.  A fire that has exceeded or is anticipated to 
exceed preplanned initial action capabilities, fire management 
direction, or selected appropriate suppression response.

extinction moisture content.  The fuel moisture content, 
weighted over all the fuel classes, at which the fire will not 
spread.

F
failed fire report.  A record, which contains the information 
from an FS-5100-29, that did not pass FIRESTAT’s error 
checking process.

fine fuels.  The complex of living and dead herbaceous 
plants and dead woody plant materials less than one-fourth 
inch in diameter.

Fine Fuel Moisture (FFM).  An adjustment to the 1-h TL 
FM that compensates for the presence of living plant material 
and the moisture content of that material.  The FFM is used in 
the manual calculation of fire-danger ratings.  It replaces the 1-
h TL FM and the herbaceous fuel moisture.

firebrand.  Any source of heat, natural or human-made, that 
is capable of igniting natural fuels.

fire-danger rating area.  A geographical area within which 
the fire danger can be assumed to be uniform.  It is relatively 
homogenous in climate, fuels, and topography.

fireline intensity.  The rate of heat release per unit length of 
fire front.  The most commonly used units in current fire 
literature are Btu/sec/ft.

fire management direction.  Fire management standards, 
guidelines, and practices based upon land and resource 
management objectives.  Fire management direction defines 
the kind, level, and timing of fire protection and use activities, 
including the appropriate suppression strategies that efficiently 
meet management objectives for each management area for 
the range of expected fire behavior conditions.

flaming front.  That zone of a moving fire where the 
combustion is primarily flaming.  Behind the flaming front the 
combustion is primarily glowing or involves the burning out of 
larger fuels (greater than about three inches in diameter.)

FM1 = FM10.  When checked, this flag signifies that the 1-
hour fuel moisture is equal to the 10-hour fuel moisture.  Used 
in NFDRS calculations.

forecast area.  The geographical area for which a fire 
weather forecast is specified.

Forest Service acres.  The total of National Forest System 
lands within a fire perimeters regardless of Region and Forest.

Freeze Day of Year.  The day of the year (1 to 365) 
considered to be the historic average day for the first killing 
frost.  Used in NFDRS calculations.

fuel class.  A group of fuels possessing common 
characteristics.  In NFDRS, dead fuels are grouped according 
to their timelag (1-, 10-, 100-, and 1000-hr TL).  Living fuels 
are grouped by whether they are herbaceous (annual or 
perennial) or woody.

fuel model.  A simulated fuel complex for which all the fuel 
descriptors required by the mathematical fire spread model 
have been specified.

fuel moisture analog.  A device that emulates the moisture 
response of specific classes of dead fuels.  Examples are 
basswood slats that represent the 1-h TL fuels and half-inch 
ponderosa pine dowels that represent the 10-h TL fuels.  An 
analog may also be constructed of inorganic materials.

Fuel Moisture Content (also Fuel Moisture) (FM).  The 
water content of a fuel particle expressed as a percent of the 
ovendry weight of the fuel particle.

fuel proportion.  That length of the traverse distance on a 
segment, divided by the total length of the assessment line.

G, H
greenup.  The beginning of a new cycle of plant growth.  The 
greenup date may occur at different dates for different fuel 
models.

herb.  A plant that does not develop woody, persistent tissue 
but is relatively soft or succulent and sprouts from the base 
(perennials) or develops from seed (annuals) each year.  
Included are grasses, forbs, and ferns.

herbaceous fuels.  Undecomposed material, living or dead, 
derived from herbaceous plants.

herbaceous vegetation moisture content.  The water 
content of a live herbaceous plant expressed as a percent of the 
ovendry weight of the plant.
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holdover fires (also sleeper fires).  Fires set by lightning 
but not discovered during the first burning period.  In the 
NFDRS it is assumed that 25 percent of the fires are not 
discovered until succeeding burning periods.

Human-caused Fire Occurrence Index (HCOI).  A 
value derived from the Human-caused Risk (HCR) sources in 
a rating area and the Ignition Component (IC).  HCOI is 
interpretable in terms of expected numbers of fires on the 
rating area.

Human-caused Risk (HCR).  A number related to the 
expected number of human-produced firebrands capable of 
starting fires that a rating area will be exposed to during the 
rating period.

human-caused risk scaling factor.  A number relating 
human-caused fire incidence to the Ignition Component (IC) 
on a rating area.  The factor is a statistic based on three to five 
years of fire occurrence and fire weather data that adjusts the 
prediction of the basic human-caused fire occurrence model to 
fit local experience.

humidity.  A measure of the water-vapor content of the air.

I
Ignition Component (IC).  A rating of the probability that a 
firebrand will cause a fire requiring suppression action.

initial action.  The prompt, preplanned response to a 
wildfire.

initiating fire.  A fire that has recently started and is not 
crowning or spotting.

insolation.  Solar radiation received at the earth’s surface.

instrument shelter (also thermoscreen).  A naturally or 
artificially ventilated structure used to shield temperature-
measuring instrucments from direct sunshine and 
precipitation.

K, L
KCFAST, KCFAST/PC.  A menu-based computer 
application that automatically builds and submits customized 
jobs from your personal computer to the IBM mainframe 
computer at the USDA National Information Technology 
Center in Kansas City.

lesser live fuels.  Grasses and forbs; low nonwoody plants, 
annual and perennial.

Lightning Activity Level (LAL).  A numerical rating of 
one to six, keyed to the start of thunderstorms and the 
frequency and character of cloud-to-ground lightning, 

forecasted or observed on a rating area during the rating 
period.

Lightning Fire Occurrence Index (LOI).  A numerical 
rating of the potential occurrence of lightning-caused fires.

Lightning Risk (LR).  A number related to the expected 
number of cloud-to-ground lightning discharges capable of 
staring fires that a rating area will be exposed to during the 
rating period.

lightning risk scaling factor.  A factor derived from local 
thunderstorm and lightning-caused fire records that adjusts the 
predictions of the basic lightning fire occurrence model to 
local experience.  It accounts for factors not addressed directly 
by the model such as susceptibility of local fuels to ignition by 
lightning, fuel continuity, topography, and regional 
characteristics of thunderstorms.

litter.  The top layer of the forest floor, typically composed of 
loose debris such as branches, twigs, and recently fallen leaves 
or needles; little altered in structure by decomposition.

live fuels.  Naturally occurring fuels whose moisture content 
is controlled by physiological processes within the living 
plant.  The NFDRS considers only herbaceous plants and 
woody plant material small enough (leaves and needles, and 
twigs) to be consumed in the flaming front of a fire.

M, N
mobilization.  Documented procedures in the National 
Interagency Mobilization Guide that defines two categories for 
equipment and supplies.  E (equipment) requests include 
major fire fighting items such as rolling stock, radios, 
telecommunications equipment, national caterers, national 
showers, cache vans ATMUs, and speciality items.  S (supply) 
requests include most NFES cache items.

National Fire Danger Rating System (NFDRS).  A 
uniform fire-danger rating system that focuses on the 
environmental factors that control the moisture content of 
fuels.

National Information Technology Center (NITC).  The 
USDA National Information Technology Center in Kansas 
City.

National Interagency Fire Management Information 
Database (NIFMID).  An Oracle database that contains 
wildland fire report and weather data.

Net Value Change (NVC).  The sum of the changes in 
resource values on a land area that results from increases 
(benefits) and decreases (damages) in resource outputs as a 
consequence of fire.



FIRESTAT User’s Guide Glossary

G.4 version 5.2 January 10, 2002

non-FS acres protected by FS.  The total of non-National 
Forest System lands within Forest Service protection 
boundaries regardless of ownership.

O
1-hour timelag fuels.  Fuels consisting of dead herbaceous 
plants and roundwood less than one-fourth inch in diameter.  
Also included is the uppermost layer of litter on the forest 
floor.

1-hour Timelag Fuel Moisture.  The moisture content of 
the 1-hour timelag fuels.

100-hour timelag fuels.  Dead fuels consisting of 
roundwood one to three inches in diameter, and, very roughly, 
the forest floor from three-fourths inch to four inches below 
the surface.

100-hour Timelag Fuel Moisture.  The moisture content 
of the 100-hour timelag fuels.

1000-hour timelag fuels.  Dead fuels consisting of 
roundwood three to eight inches in diameter or the layer of the 
forest floor more than about four inches below the surface or 
both.

1000-hour Timelag Fuel Moisture.  The moisture content 
of the 1000-hour timelag fuels.

outside FS protection.  The total of non-National Forest 
System lands outside Forest Service protection boundaries.

P
perennial.  A plant that lives fro more than two growing 
seasons.  For fire-danger rating purposes, biennial plants are 
classed with perennials.

precipitation.  Any or all the forms of atmospheric water, 
liquid, or solid that reach the ground.  Usually measured to the 
nearest one-hundredth of an inch.

precipitation duration.  The time, in hours and fraction of 
hours, that a precipitation event lasts.  More precisely, for fire-
danger rating purposes, it is the length of time that fuels are 
subjected to liquid water during the day.

prescribed fire.  A wildland fire burning under preplanned, 
specified conditions to accomplish specific planned 
objectives.  It may result from either a planned or unplanned 
ignition.

prescribed natural fire.  A fire resulting from a natural 
ignition that is designated and managed as a prescribed fire.

R
Relative Humidity.  The ratio of the actual amount of water 
vapor in the air to the amount necessary to saturate the air at 
that temperature and pressure.  It is expressed as a percentage.

Remote Automatic Weather System (RAWS).  A 
WIMS satellite station that automatically tracks and stores 
weather information.

residence time.  1.  The time required for the flaming zone 
of a fire to pass a stationary point.  2.  The width of the flaming 
zone divided by the rate of spread of the fire.

roundwood.  Boles, stems, or limbs of woody material; that 
portion of the dead wildland fuels that are roughly cylindrical 
in shape.

S
shrub.  A woody perennial plant differing from a perennial 
herb by its persistent and woody stem; and from a tree by its 
low stature and habitat of branching from the base.

slash.  Branches, bark, tops, cull logs, uprooted stumps, and 
broken or uprooted trees left on the ground after logging; also 
debris resulting from thinnings or wind.

slope.  Rise or fall (in feet) per 100 feet of horizontal 
measurement, expressed as a percentage.

Spread Component. (SC).  A rating of the forward rate of 
spread of a head fire.

standard drying day.  A day producing the same net drying 
as a 24-hour period where the dry bulb temperature is 
maintained at 80° F and the relative humidity at 20 percent.

Staffing Index.  A code that identifies the fuel model and 
forms the basis for fire-danger rating decisions.

statistical wildfire.  A wildfire that burns uncontrolled in 
vegetative or associated flammable material and either 
requires suppression action to protect natural resources or 
values associated with natural resources, or is destructive to 
natural resources.

surface area-to-volume ratio.  The ratio of the area of the 
surface of a fuel particle (square feet) to its volume (cubic 
feet).  The higher the ratio, the finer the particle; for example, 
for grasses this ratio ranges above 2,000; for a half-inch fuel 
moisture stick it is 109.
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T
10-hour timelag fuels.  Dead fuels consisting of 
roundwood one-fourth to one inch in diameter and, very 
roughly, the layer of litter extending from just below the 
surface to three-fourths inch below the surface.

10-hour Timelag Fuel Moisture.  The moisture content of 
the 10-hour timelag fuels.

trend forecast.  A forecast that generates point forecasts by 
trending today’s observed weather for a weather station.

total fire aces.  The total acres burned within a fire 
perimeter regardless of ownership.

U, V
unplanned ignition.  A fire started at random by either 
natural or human causes, or a deliberate incendiary fire.

volatiles.  Readily vaporized organic materials which, when 
mixed with oxygen, are easily ignited.

W
Weather Information Management System (WIMS).  A 
comprehensive system that manages fire-weather information.

wildfire.  An unwanted wildland fire not designated and 
managed as a prescribed fire and that requires appropriate 
suppression action.

windspeed.  Wind, in miles per hour, measured at 20 feet 
above the ground or the average height of the vegetative cover, 
and averaged over at least a ten minute period.
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